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1.1 The Tolomatic ACS Drive/Controller
It is important to know which model Tolomatic ACS Drive/Controller you are 
programming. The stepper and servo units are the same size, color and externally 
are only different on the left panel. Use the part number on the label to confirm the 
Tolomatic ACS Drive/Controller before programming. 

Figure 1-1: ACS Drive Controller part number identification

 NOTE: They will collectively be referred to as ACS Drive throughout this guide

 NOTe:  
It is important to identify the 
motor and corresponding 
ACS drive system (Stepper 
or Servo) being used! 
Because the TMI software 
allows an offline connection 
that does not require the 
Tolomatic drive. This offline 
connection allows users to 
create, edit and save drive 
configuration files.

Product Overview1

Information that ONLY applies 
to Stepper Drives will be 
noted in grey box:

ACS Stepper Drive 
ST1048

Information that ONLY applies 
to Servo Driveswill be noted 
in light blue box:

ACS Servo Drive 
SV2048

Information that applies to 
Servo Drives & ACSI Motor/
Drive will be noted in light 
purple box:

Servo Drive

Information that ONLY applies 
to ACSI will be noted in light 
red box:

ACSI Motor/Drive/Contr. 
ASCI

 NOTe: Throughout 
this manual information 
is color coded as it 
applies to products

ACS Stepper Drive
Currently (beginning 01/21/2015) there are three ACS Stepper Drive/Controller choices: 
 • #3604-9665 (ACST1048UD) - ACS Stepper Drive/Controller, Basic  
    firmware 36043183.TOL
 • #3604-9666 (ACST1048ED) - ACS Stepper Drive/Controller, EtherNet/IP  
    firmware 36043183.TOL
 • #3604-9667 (ACST1048MD) - ACS Stepper Drive/Controller, Modbus TCP 
    firmware 36043183.TOL

ACS Servo Drive
Currently there are three ACS Servo Drive/Controller choices: 
 • #3604-9661 (ACSV2048UD) - ACS Servo Drive/Controller, Basic 
    firmware 36043177.tol
 • #3604-9662 (ACSV2048ED)- ACS Servo Drive/Controller, EtherNet/IP  
    firmware 36043177.tol
 • #3604-9663 (ACSV2048MD)- ACS Servo Drive/Controller, Modbus TCP  
    firmware 36043177.tol

ACSI Motor / Drive / Controller
Currently (beginning 01/01/2018) there are ten ACSI Motor/Drive/Controller choices:
• Basic #3604-9740 (ACSI23-1Q1-B) #3604-9770 (ACSI34-1Q1-B) ACSI  

Integrated Servo Motor/Drive/Controller, firmware 36043171.TOL
• EtherNet/IP #3604-9746 (ACSI23-1Q1-E) #3604-9776 (ACSI34-1Q1-E) ACSI  

Integrated Servo Motor/Drive/Controller, firmware 36043171.TOL
• Modbus TCP #3604-9752 (ACSI23-1Q1-M) #3604-9782 (ACSI34-1Q1-M) ACSI  

Integrated Servo Motor/Drive/Controller, firmware 36043171.TOL
• EtherCAT #3604-9856 (ACSI23-1Q1-C) #3604-9872 (ACSI34-1Q1-C) ACSI  

Integrated Servo Motor/Drive/Controller, firmware 36043171.TOL
• PROFINET #3604-9864 (ACSI23-1Q1-P) #3604-9886 (ACSI34-1Q1-P) ACSI  

Integrated Servo Motor/Drive/Controller, firmware 36043171.TOL

DISCONTIN
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P R O D U C T  O V E R V I E W

The user guide indicates functions that apply to specific Drive/Controllers. If there is 
no indication, the information applies to all Tolomatic ACS Drive/Controllers.

ACS Stepper Drive ST1048

Figure 1-2: example of Stepper Only information

Servo

Figure 1-3: example of Servo Drive & ACSI Motor/Drive/Controller information

FOR eXAMPLe: THe TuNING FILTeR TOOL (CHAPTeR 16) IS ONLY AVAILABLe FOR SeRVO. 
WHeN THe SeRVO DRIVe IS CONNeCTeD TO THe COMPuTeR THe SOFTWARe WILL DeTeCT 
THe DRIVe AND THe TuNING FILTeR TOOL WILL Be AVAILABLe. CONVeRSeLY, WHeN 
CONNeCTeD TO A STePPeR DRIVe THe TuNING FILTeR TOOL WILL NOT Be AVAILABLe.

DISCONTIN
UED
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Host Computer Requirements2
2.1 Host Computer and Software System Requirements

The Tolomatic Motion Interface (TMI) is designed to work with a host PC with 
Windows® operating systems.  Before installing the TMI software, be sure the host 
PC has the minimal host requirements indicated below. 

2.1.1 Hardware Requirements
HARDWARe MINIMuM ReQuIReMeNT

Processor 1 GHz

RAM 512 MB

Disk Space 32-Bit 600 MB

Disk Space 64-Bit 1.5 GB

USB 1 USB 2.0 Connection

Table 2-1: Hardware Requirements

2.1.2 Operating Systems Supported
The Tolomatic Motion Interface (TMI) is compatible with the following operating 
systems: Windows® 7, Windows® 8, and Windows® 10.

For all platforms, it is recommended that you upgrade to the latest Windows Service 
Pack and critical updates from the Windows Update Web Site at http://go.microsoft.
com/fwlink/?LinkId=168461 to ensure the best compatibility and security.

The TMI software is not supported on IA-64-based (Itanium) systems.

 NOTE: Tolomatic highly 
recommends configuration 
and upgrading using a 
USB 2.0 port. Slower USB 
ports may introduce slower 
response times with TMI and 
firmware upgrades.

DISCONTIN
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Installing the TMI Software 3
3.1 Installation Instructions

3.1.1 Installing from the Tolomatic CD
1. Insert the software CD supplied by Tolomatic into the CD-ROM drive in your PC.

2. Double-click the "TolomaticMotionInterface[version].exe" file to run  
the installer. 

3. Follow the prompts to install the software.

The software will install a program launch icon in the Windows® Start menu at:  
Start > All Programs > Tolomatic > TolomaticMotionInterface

In the Start menu the program will start with a single click. 

3.1.2 Downloading and Installing from the Tolomatic Web 
Site at www.tolomatic.com
The Tolomatic Motion Interface can be downloaded from the Tolomatic web site at 
www.tolomatic.com

1. To download, click on "Info Center" in the navigation bar at top. Select 
"Software" under "Product Support." Select "Software Firmware;" select the: 
"Current   Tolomatic Motion Interface" the current and archive TMI 
software is available. 

2. Select the TMI software and when prompted save the file to the programs 
folder on your hard drive. 

3. Double-click the executable file to run the installer. 

4. Follow the prompts to install the software.

The software will install a program launch icon in the Windows® Start menu at:  
Start > All Programs > Tolomatic > TolomaticMotionInterface

In the Start menu the program will start with a single click. 

DISCONTIN
UED
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Starting the TMI Software4
4.1 Launching the TMI Software

1. To launch the software in the Windows® Start menu navigate to: Start > All 
Programs > Tolomatic > TolomaticMotionInterface

2. When the TMI is launched for the first time, the software will automatically 
display the User Units dialog box (shown below, Figure 4-1) which defines the 
units displayed in the software.  The user has four selections for linear actuator 
units:  US Linear, SI Linear, US Rotary, SI Rotary. 

Figure 4-1: user unit Dialog Box

3. The user must select the desired units and click Apply.  Once the apply button 
is clicked TMI will no longer automatically display the User Units dialog box on 
application launch. To access the User Units dialog box click on the ruler icon 
in the tool bar at top. The units can be changed at any time and all displayed 
parameters in the software will be adjusted accordingly.   

Figure 4-2: user unit Tool Icon in menu

Note: Default Rotary units 
are Revs. When a rotary 
actuator is chosen, most 
applications should use 
revs. Degrees is avaliable, 
but has limitations on 
rollover and limits. 

DISCONTIN
UED
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Establishing Communication5
5.1 establishing Communication with the Tolomatic ACS Drive

The communications protocol used for configuration uses USB cable. 

1. After the User Units have been selected on initial startup, and from then on 
once the TMI is launched, the software will automatically default to the Drive 
tab shown in Figure 5-1 below.

Figure 5-1: Drive Tab Showing ACS Drive Disconnected

2. When the 'Auto' option is selected for the port, TMI attempts to detect the 
presence of ACS servo or stepper drive on any of the COM ports available 
on the computer. When the drive is connected it will show up as a Com-
Port in Windows Device Manager. The ACS drive must be powered on 
for communication with the PC in order for the discovery sequence to be 
successful. (If no ACS Drive is found, the status bar (at bottom) will display 
"Disconnected" and the text box will display "Unable to connect to ACS 
Drive" message.)  The user may also select a specific port from the list of 
available COM ports. TMI will prompt you to install drivers if drivers 
are required to connect to the drive. For proper operation be sure that 
both the TMI software and associated drivers are up-to-date. Once successful 
communication is established, the TMI will remember that port for subsequent 
sessions. 

3. Upon establishing communication with the ACS Drive, the TMI software reads 
all the current settings in the ACS Drive and updates the software interface 
accordingly. As shown in Figure 5-2, the ACS Drive information is displayed 
in several fields: Name of ACS Drive given by user; ACS Drive information 
including Model and Firmware Version;  and a Photo of the Tolomatic ACS Drive 
product being configured (ACS Drive/Controller is pictured). If the ACS Drive has 
Network hardware the MAC address will also be displayed.

 NOTe: The TMI 

software allows an 

offline connection 

that does not require 

the Tolomatic 

drive. This offline 

connection allows 

users to create, 

edit and save drive 

configuration files.

  

TROuBLeSHOOTING TIP: 

If TMI is prompting you 

to install drivers and you 

have already done so, 

power cycle the drive 

and try to establish a 

connection again.

  

TROuBLeSHOOTING TIP: 

When Drivers are properly 

installed, ACS will show 

up under "Ports" object in 

Windows Device Manager.
DISCONTIN

UED
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Figure 5-2: Drive Tab Showing ACS Drive Connected

4. The TMI software opens a Software Stop window shown in Figure 5-3.  This 
Software Stop window is intended to be a software motion stop.  If the user 
clicks on the stop button, the actuator will immediately stop. The Tolomatic ACS 
Drive will be disabled along with the output to the motor.  For safety reasons 
this window is intended to always be on top of other windows.  

Figure 5-3: Software Stop

5. The Name text box allows the user to name the drive/axis.  This is helpful when 
configuring multiple drives.  

6. When connecting to the drive, the user may experience a Bus Voltage Mismatch 
warning message.  This occurs when the drive is configured for a specific bus 

DISCONTIN
UED
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voltage and the drive detects a different supply voltage.  When first configuring 
the drive, make sure to set the Bus Voltage to the correct supply voltage for the 
application.  

Figure 5-4: Bus voltage mismatch

5.2 Offline Connection
The TMI software supports an offline connection that allows the user to create, edit 
and save drive configuration files without the Tolomatic ACS Drive being present.  
This is a useful development and debug tool to create and analyze the drive 
configuration files.  

With the Offline connection, all controls related to motion, tuning and enabling/
disabling drive are disabled.  The offline connection does not allow the user to 
simulate motion, debug logic, or tune servo motors.

Figure 5-5: Offline connection

  

TROuBLeSHOOTING TIP: 

For Servo Drives, Bus 

Voltage drastically affects 

tuning. Drive should be 

configured and tuned at 

the bus voltage of the 

application. Faliure to do 

so will result in excessive 

vibration and poor motion.

DISCONTIN
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Navigating through the TMI Software6
6.1 Navigating through the Tolomatic Motion Interface (TMI)

6.1.1 Setup Wizard Tabs
The TMI software for configuring the ACS Drive is designed as a setup wizard. It 
uses tabs, navigating from left to right through all the steps needed to configure the 
ACS Drive and create motion.  As shown below, there are multiple tabs which are 
used in the setup process.

TMI Setup Wizard Navigation Tabs

Drive Establish communication and verify ACS Drive identification information such as 
model and firmware version.

Actuator Configure a Tolomatic actuator or create a custom actuator in the “Other Actuator 
Catalog.”

Motor Configure or view parameters of a Tolomatic motor or create a 3rd party motor file 
in the “Other Motor Catalog.”

Mode 
Select 

Select the desired operating mode.  Tolomatic ACS Drive products were designed 
to have dedicated operating modes to simplify the configuration and operation of 
the ACS Drive.  Currently, there are four operating modes, depending on model:  
Index Move, Pneumatic, Analog Position and Network (EtherNet/IP, ModbusTCP, 
Modbus RTU)

I/O Configure the functionality of the digital inputs and digital outputs of the ACS Drive.  
The TMI will automatically configure a suggested I/O map based on the selected 
operating mode. 

Fault Enable/disable faults, and configure the action taken for the displayed faults.

Safety/
Limits

Configure safety parameters and motion limits such as:  in position, position error, 
maximum velocity/accel/decel, current limit, software limits and zone bounds

Home 
Setup

Configure the homing routine parameters such as type, direction, velocity, force, 
and home on power-up.

Mode 
Setup

Setup the operating Mode selected in the Mode Setup tab.  For example, in 
Index Move mode, the user configures move type, position, velocity, acceleration, 
deceleration and force for all the moves.  

Table 6-1: TMI Setup Wizard Navigation Tabs

6.1.2  Tolomatic Logo
The TMI software uses the Tolomatic Logo  
to guide the user through the software in order to correctly configure all necessary 
parameters.  Notice in the drawing above that the ACS Drive is connected, the 
Tolomatic logo has moved to the Actuator tab which is the next required step–
configuring the actuator.  The Drive tab remains highlighted in Blue which gives the 
user visual indication of the currently selected tab.  

DISCONTIN
UED
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6.1.3 Tool Bar

Figure 6-1: Tolomatic Motion Interface (TMI) Tool Bar

The Tool Bar includes the following:  

Drive Connect:  Connect or disconnect communication to the ACS 
Drive.

Ethernet Setup (optional):  Set up ACS Drive for Ethernet 
communication.

Open:  Open a previously saved drive configuration file to setup all the 
parameters of the ACS Drive.  

Save:  Save all parameters to a drive configuration file for later use.

Restore Current Settings from Drive Flash:  Read all parameters 
from drive flash memory into the TMI software.

Write Current Settings to Drive Flash:  Write all parameters from 
the TMI software into the drive flash memory.

Software Stop:  Disables ACS Drive and output to the motor

Home:  Initiates a home routine

 
Motion Manager tool:  Tool used to create simple moves such as 
absolute, incremental and jog.  All motion profile parameters are 
adjustable through this tool.  

DISCONTIN
UED



 ACSI Motor/Drive/Controller User Guide:           TMI Motion Control Interface
 •  23  •ACS Drive: DISCONTINUED Product 05/02/2022 For legacy ACS drive, use this manual for reference only.

N A V I G A T I N G  T H R O U G H  T H E  T M I  S O F T W A R E

ACS Servo Drive / 
ACSI

Tuning Filter tool:  Tool used to tune servo motors (advanced users)

Drive Status tool:  Tool used to notify user of critical drive information 
such as Enable status, Home status, In Position status and Faults (see 
Section 20: Drive Status Tool). 

Digital I/O tool:  Tool used to view the status of the Digital Inputs and 
Digital Outputs (see Section 17: Digital I/O Tool).

Analog I/O tool:  Tool used to view the status of the Analog Inputs and 
Analog Outputs (see Section 18 Analog I/O Tool).

 

4 Channel Software Oscilloscope:  Tool used to view signals on the 
drive.

 
User Units tool:  Tool to select application user units.  At time of this 
release, linear units are selected in inches, millimeters and revolutions.

 

6.1.4 Tool Tips
As the user moves the mouse over Tool Bar items, drive parameters or action 
buttons, the TMI will display a tool tip providing useful information about that item.  

Figure 6-2: Tool Tips Display 

Tool Tip Displays:  Moving the mouse over a parameter field will activate the 
Tool Tips display and it will show the allowable range for that parameter. If a 
user attempts to enter a lower number than is allowed, the TMI software will 
automatically default to the minimum allowable value.  If a user attempts to enter a 
higher number than is allowed, the TMI will automatically default to the maximum 
allowable value.  

 
Figure 6-3: Parameter Range in Tool Tip Display

DISCONTIN
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6.1.5 Parameter entry
Red Parameter Field:  The TMI will automatically shade any parameter field a red 
color if that parameter has not been configured (see Figure 6-4).  This is a notice to 
the user that this parameter must be configured before continuing or creating motion.  

Figure 6-4: Red Parameter Fields

6.1.6 File Menu

Figure 6-5: File Menu Options

File Menu Drop Down Descriptions
Open Open a drive configuration file to setup all the parameters of the ACS 

Drive.

Save Saves all parameters to a drive configuration file. If user hasn't given a 
name to the file yet, a File Save window will be opened.

Save As Opens a File Save window to allow user to select location and name of 
drive configuration file.

Session Restore Restore a previous waypoint.  While drive is being configured, 
waypoints are automatically saved in the session. 

Write Current Settings 
to Drive Flash

Write all parameters from the TMI software into the drive flash memory.

Read Current Settings 
from Drive Flash

Read all parameters from drive flash memory into the drive's RAM and 
into the TMI software.

Restore Drive to 
Factory Settings

Restores all parameters in the ACS Drive flash and RAM memory to 
factory defaults. 

Read Current Settings 
from Drive RAM

Reads all parameters in ACS Drive RAM into the TMI software 
(Performed automatically when communication is established)

exit Exits the application

Table 6-2: File Menu Drop Down Descriptions

 NOTe: Executing any 
Open, Restore or Read 
operation will result 
in the TMI software 
automatically navigating 
to the Drive Tab and 
updating all parameters 
in TMI to the current 
drive settings.

DISCONTIN
UED
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 ACS Servo Drive / ACSI

6.1.7 Tools Menu

Figure 6-6: Tools Menu

Tools Menu Drop Down Descriptions
Motion Manager Used to create simple moves such as absolute, incremental and 

jog.  All motion profile parameters are adjustable through the Motion 
Manager tool.  

Tuning Filter Used to tune servo motors

Drive Status Used to notify user of critical drive information such as Enable status, 
Home status, In Position status and Faults

Digital I/O Used to view the status of the Digital Inputs and Digital Outputs.

Analog I/O Used to view the status of the Analog Inputs and Analog Outputs.

4 Channel Software 
Oscilloscope

Software tool used to analyze drive parameters

user units Used to select application user units.  At time of this release, units are 
selected in inches or millimeters.

Software Stop Used to disable ACS Drive and output to the motor.  This tool is 
automatically launched when the TMI software connects to the ACS 
Drive.

ethernet Setup 
(optional)

Set up ACS Drive for Ethernet communication.

Advanced Diagnostics Used for advanced diagnostics and troubleshooting.

Communications 
Counters

Used to diagnose USB communications issues.

upgrade ACS 
Firmware

Used to upgrade the firmware for the ACS. 

Table 6-3: Tools Menu Drop Down Descriptions

DISCONTIN
UED
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6.1.8 Help Menu

Figure 6-7: Help Menu Drop Down Options

Install ACS Drivers: Installs the drivers for the USB enabled ACS Drives.

ACS Stepper Hardware & Installation Guide: Launches a PDF of the manual 
with ACS Stepper Drive specifications, wiring diagrams, connector and cable 
information.

ACS Servo Hardware & Installation Guide: Launches a PDF of the manual with 
ACS Servo Drive specifications, wiring diagrams, connector and cable information.

Tolomatic Motion Interface (TMI) Software Guide: Launches a PDF of this 
manual. 

ACS [Network Mode] Manual: Launches a drive specific PDF of the manual for 
supported network mode. 

About: Indicates the current software version of the Tolomatic Motion Interface and 
the build date.

email Problem Report: Launches local email application with log file attachments 
that can be sent to Tolomatic in the event of an issue. 

 

Figure 6-8: About Window 

DISCONTIN
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Actuator The Actuator Tab 7
The Actuator tab is used to configure a Tolomatic actuator or define a new actuator.  
The default selection of the radio button is Tolomatic Actuator.

7.1.1 Tolomatic Actuator Selection
1. Identify the actuator configuration string on the actuator.  Enter Model, Size, 

Screw/Nut Lead, Stroke Units (either SM for mm, or SK for inches), length of 
Stroke in units specified, Motor Mount, and Motor option.  

Figure 7-1: Configuration string on eRD actuator

2. When Model is configured, a photo of the actuator will be shown.  

Figure 7-2: Configuring the Tolomatic Actuator Selection

 NOTe: When complete configuration string is entered the Tolomatic logo will 
move to the next tab requiring attention.

3. Copy to Other Actuator: Creates a new actuator in the Other Actuator Selection 
based on the defined Tolomatic Actuator.

4. Reflected Inertia Match: Set initial inertia of the system.

7.1 using the Actuator Tab

  

TROuBLeSHOOTING TIP: 

If Servo motor vibrates 

on enable, lower reflected 

inertia match to "1," then 

increase as applicable. 

Inertia is a base tuning 

for servo motors. More 

advance tuning can be 

done using Tuning Filter 

too.

 NOTe: ALL 

standard Tolomatic 

electric actuators 

can be selected 

from the model drop 

down menu. Some 

custom actuators 

may require use of 

"Other Actuator" to 

configure. 

DISCONTIN
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7.1.2 Rotary Actuator 
The Rotary Actuator selection allows a user to configure the drive for Rotary 
operation.

Figure 7-3: Selection of rotary mode for use with ACSI

1. Selecting the Units will map the System Units to the User Units which means 
that in network modes, the user can use the rotary units for distance, velocity, 
acceleration, and deceleration values.

2. Motor Option allows the user to select the motor to use

3. Reflected Inertia Match allows the user to change the inertia values for tuning

7.1.3 Custom (Other) Actuator Selection
The Custom (Other) Actuator Catalog allows a user to keep any number of Other 
Actuator models in the file for convenience and later reference.

1. If no Other Actuators have been created there will be no selections under the 
Models drop down.  In this case, the user must click the New button at the 
bottom of the screen (see Figure 7-4).

Figure 7-4: Selection of Other Actuators

2. Clicking the New button, will bring up a New Actuator dialog in which the user 
must enter critical information about the actuator (see figure 7-5)

 NOTe: Tolomatic 

recommends "Revs" for 

rotary units. Degrees 

support is limited to single 

revolution applications. 

DISCONTIN
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3. Model field:  Enter the name selected for the Other Actuator.  It will remain red 
until the user enters a unique name that has not already been saved into the 
Other Actuator Catalog.  

4. Description field:  Enter a unique description of the Other Actuator, up to a 28 
alpha-numeric character entry that is all uppercase. This field is optional.

5. Stroke field:  Enter the stroke in the selected user units.  

Figure 7-5: New Actuator Window

6. Linear Units Ratio field: These numerator and denominator entries are used to 
setup the ratio of rotary motor revolutions to linear distance in selected user 
units per motor revolution. If there is a gearbox inline with the motor, this ratio 
must be taken into account and entered accordingly.  

 For example, if there is an Other Actuator with an 0.5" (two turns per inch)  
lead screw, then the Linear Units Ratio would look as in Figure 7-6 below.  All 
the required fields have been entered properly and the parameters have been 
validated. This  activates the Save button. 

Figure 7-6: New Actuator Window Data entry Complete

 

7. Allow Rotary Moves Types allows velocity and other rotary moves to be 
accessible. If this motor is connected to a linear actuator it is recommended 
that this remain unchecked.  Linear units ratio must also be set to 1:1.

DISCONTIN
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8. Clicking the save button adds the New Actuator information to the Other 
Actuator catalog. The name of the new actuator is automatically added to the 
Model drop down for later reference.  

Figure 7-6: Other Actuator Window with Multiple Model Drop Down Display

9. Button descriptions:  
New:  Create new actuator 
Edit:  Edit existing actuator previously saved 
Delete:  Delete selected actuator 
Copy:  Create a new actuator based on selected existing actuator

DISCONTIN
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Motor

ACS Stepper Drive

The Motor tab is used to configure a Tolomatic motor or create a different motor in 
the Other Motor Catalog. The default selection of the radio button is Tolomatic Motor.  

8.1.1 Tolomatic Motor Selection
1. Verify the correct Motor selection and settings are displayed.  

2. All parameters except the Reverse Direction check box are automatically 
populated with those of the selected motor and are disabled from entry.  

 If the user wishes to select a different motor Model that is acceptable for the 
actuator chosen, then simply select a new motor from the Model drop down.  

3. Depending on the actuator configuration or the actuator installation in the 
machine, the user may wish to reverse the direction of the motor's positive 
direction. Default positive motion direction is CW (clockwise) when viewed 
toward output shaft of motor. To change it to CCW (counter-clockwise), the 
Reverse Direction check box must be checked.

Figure 8-1: Motor Tab with Tolomatic Stepper Motor Selected

The Motor Tab8
8.1 using the Motor Tab

 NOTe: At the 

time of this release, 

servo drives do 

NOT support "Other 

Motor" configuration.

DISCONTIN
UED
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Figure 8-2: Motor Tab with Tolomatic Servo Motor Selected

 NOTe:  Servo does not currently support "Other Motor".

DISCONTIN
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ACS Stepper Drive
8.1.2 Other Motor Selection

The Other Motor catalog allows a user to keep any number of motor models 
compatible with the ACS Drive in the file for convenience and later use.  Selection 
of a motor other than one supplied by Tolomatic is done in a similar procedure as 
selecting an Other Actuator.

1. If no Other Motors have been created there will be no selections under the 
Models drop down (see Figure 8-3). In this case, the user must click the New 
button at the bottom of the screen.

Figure 8-3: Other Motor with no Model Choices Available

2. Clicking the New button, will bring up a New Stepper Motor dialog box in which 
the user must enter the motor name, description (28 alpha-numeric characters 
in uppercase), and specifications. Once the information entered has been 
validated, the light red fields will disappear and the save button will become 
active.

3. Clicking the save button adds the New Motor information to the Other Motor 
catalog. The name of the new motor is automatically added to the Model drop 
down for later reference.  

4. Depending on the actuator configuration or the actuator installation in the 
machine, the user may wish to reverse the direction of the motor's positive 
direction. When facing motor mounting end, default positive motion direction is 
CW (clockwise). To change it to CCW (counter-clockwise), the Reverse Direction 
check box must be checked.
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ACS Stepper Drive

Figure 8-4: edit Stepper Motor Window with Data Complete

Figure 8-5: Other Motor Window with Model Added to Drop Down Display

5. Button descriptions:     New: Create new actuator   Edit: Edit existing actuator 
previously saved   Delete: Delete selected actuator   Copy: Create a new 
actuator based on selected existing actuator
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The software supports 
four different operating 
modes:  Index Move, 
Analog Position, Pneumatic 
and Network.  Network 
mode supports one of the 
following protocols: Modbus 
RTU, EtherNet/IP, Modbus 
TCP or EtherCAT.

The Index Move mode 
supports 4, 8, and 16 
move commands.  These 
move commands can be 
configured to be Absolute, 
Incremental, Jog, Home, 
Force or No Action 
moves.  Also supports 

velocity and rotary moves. The motion 
profile can be independently set for each 
move.  The motion profile includes velocity, 
acceleration, deceleration and force which 
is setup in the Mode Setup tab (see Section 
14:  Mode Setup Tab). Index mode also 
contains the Basic Indexer.

The Analog Control mode supports both 
voltage (0 to 10 VDC) and current (4 to 20 
mA) on the analog input and analog output.  
The ACS Drive follows the analog input 
signal and commands the actuator position 
to a scaled position as distance/volt or 
scaled velocity as speed / volt.

The Pneumatic mode is used to replace or 
mimic pneumatic cylinder/valve operation 
logic. With pneumatic mode there are four 
different selections: Spring, 2 Position (2 
input), 3 Position (2 input) &, 3 Position 
(3 input). These four pneumatic mode 
operations allow just about any pneumatic 
valve logic to be replaced with the ACS 
drive. Additionally, in pneumatic mode,  
the drive will automatically home the 
actuator upon power up based on the home 
setup configuration.

ACS Servo DriveACS Stepper Drive

Mode Select The Mode Select Tab 9
9.1 using the Mode Select Tab

 NOTe: The ACS stepper drive 
models and modes are as follows:

ACS 
Model

Part 
Number

Operating 
Mode

10
 -

 5
2 

VD
C 

St
ep

pe
r

ST1048uD 3604-9665

Index Move 
Analog Position 

Pneumatic 
Modbus RTU

ST1048eD 3604-9666

Index Move 
Analog Position 

Pneumatic 
EtherNet/IP

ST1048MD 3604-9667

Index Move 
Analog Position 

Pneumatic 
Modbus TCP

 NOTe: The ACS servo drive 
models and modes are as follows:

ACS 
Model

Part 
Number

Operating 
Mode

10
 -

 6
0 

VD
C 

Se
rv

o

SV2048uD 3604-9661

Index Move 
Analog Position / 

Velocity  
Pneumatic 

Modbus RTU

SV2048eD 3604-9662

Index Move 
Analog Position / 

Velocity 
Pneumatic 
EtherNet/IP

SV2048MD 3604-9663

Index Move 
Analog Position 

Pneumatic 
Modbus TCP

ACSI Integrated

 
NOTe: The ACSI motor / drive / controller models and 
modes are as follows:

ACSI Model
AM Code (used 

to order ACSI on a 
Tolomatic actuator)

Part 
Number Operating Mode

10
 -

 6
0 

VD
C 

In
te

gr
at

ed
 S

er
vo

ACSI23-1Q1-B AMI2C1A1 3604-9740
Index Move, Analog Position/

Velocity, Pneumatic, Basic 
Indexer

ACSI23-1Q1-e AMI3C1A1 3604-9746
Index Move, Analog Position/

Velocity, Pneumatic, Basic 
Indexer, EtherNet/IP

ACSI23-1Q1-M AMI4C1A1 3604-9752
Index Move, Analog Position/

Velocity, Pneumatic, Basic 
Indexer, Modbus TCP

ACSI23-1Q1-C AMI5C1A1 3604-9856
Index Move, Analog Position/

Velocity, Pneumatic, Basic 
Indexer, EtherCAT

ACSI23-1Q1-P AMI6C1A1 3604-9864
Index Move, Analog Position/

Velocity, Pneumatic, Basic 
Indexer, PROFINET I/O

ACSI34-1Q1-B AMI2D1A1 3604-9770 Index Move, Analog Position/
Velocity, Pneumatic

ACSI34-1Q1-e AMI3D1A1 3604-9776
Index Move, Analog Position/

Velocity, Pneumatic, Basic 
Indexer, EtherNet/IP

ACSI34-1Q1-M AMI4D1A1 3604-9782
Index Move, Analog Position/

Velocity, Pneumatic, Basic 
Indexer, Modbus TCP

ACSI34-1Q1-C AMI5D1A1 3604-9872
Index Move, Analog Position/

Velocity, Pneumatic, Basic 
Indexer, EtherCAT

ACSI34-1Q1-P AMI6D1A1 3604-9886
Index Move, Analog Position/

Velocity, Pneumatic, Basic 
Indexer, PROFINET I/O
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The Network mode accepts commands to change motion profile, command infinite 
positions, monitor status and provide diagnostics, using network control. 

Figure 9-1: Mode Select Tab Window - Index default

Figure 9-2: Mode Select Tab Window - Index drop-down

Figure 9-3: Mode Select Tab Window - Analog default

Figure 9-4: Mode Select Tab Window - Analog voltage drop-down

 NOTe: The TMI 

software will determine if 

ModBus RTu, etherNet/IP, 

PROFINeT. Modbus TCP, or 

etherCAT is appropriate 

based on the connected 

ACS Drive.
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Figure 9-5: Mode Select Tab Window - Analog position drop-down

Figure 9-6: Mode Select Tab Window - Pneumatic drop-down

Figure 9-7: Mode Select Tab Window - Modbus RTu

Figure 9-8: Mode Select Tab Window - etherNet/IP
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Figure 9-9: Mode Select Tab Window - Modbus TCP

Figure 9-10: Mode Select Tab Window -PROFINeT

Figure 9-11: Mode Select Tab Window -etherCAT
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I/O The I/O Tab10
10.1 using the I/O Tab

The digital input and digital output functionality are configured using the I/O tab. 
Default I/O configurations are set up for the selected mode and are shown after the 
Digital Input and Output Command Tables in Figures 10-1 through 10-4.

10.1.1 Digital Inputs

Digital Input Functionality
enable Enables or Disables the ACS Drive and power to the motor.  

NOTE:  Faults configured to Disable Motor (see Section 11: Fault 
Tab) will require PLC or logic device to cycle level of Enable input 
to re-enable the ACS Drive. Cycling this input when there is no 
feedback device will clear the Home output.

Start Motion Initiates the selected move command from the Move Select inputs. 
While input is on it prevents further motion.

Stop Motion Stops move in progress with controlled deceleration. If executed 
during a home, will declare home at current position.

Home Initiates the homing routine setup in the Home Setup tab (see 
Section 13: Home Setup Tab).

Software-stop 
(e-Stop)

Executes an immediate stop which either stops motion or disables 
ACS Drive depending on the fault configuration in the Fault tab (see 
Section 11: Fault Tab). While asserted it prevents further motion.

Move Select 1-4 Inputs 
(MS1, MS2, MS3, MS4)

Selects move for execution based on  
Index Move mode (see Appendix 1 for Move Select Logic) or 
Pneumatic mode (see Appendix 2 for Move Select Logic)

Positive Limit Switch Stops motion or disables the ACS Drive depending on the fault 
configuration in the Fault tab (see Section 11: Fault Tab). 

Negative Limit Switch Stops motion or disables the ACS Drive depending on the fault 
configuration in the Fault tab (see Section 11: Fault Tab).

Pause Indexer 
(Basic Indexer)

Pauses the currently running basic sequencer index. (Demo Mode)

enable/Start Motion 
(Basic Indexer)

Enables and initiates the selected move command from the Move 
Select inputs. (Demo Mode)

Table 10-1: Descriptions of Digital Input Functionality

Refer to Hardware Manual for I/O Timing Diagrams.

10.1.2 Digital Outputs

Digital Output Functionality
Move Complete Signal to PLC or logic device indicating whether motion is in 

progress (off) or motion is complete (on).

Home Complete Signal to PLC or logic device indicating whether ACS Drive/motor 
combination is homed (on) or not homed (off).  NOTE:  When 
homing is in progress, the Home Complete output will be off.
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ACSI

Digital Output Functionality
Fault Signal to PLC or logic device indicating that a fault has occurred.  

The steps to reset the fault are different depending on the fault 
category (see section 11: Fault Tab) for a complete description of 
faults and recovery.

Zone 
(Optional)

Signal to PLC or logic device indicating that the position of the 
actuator is within the Zone Positive Bound and Zone Negative 
Bound setup in the Safety/Limits tab (see Section 12: Safety/
Limits Tab).

Brake  
(ACSI Specific)

Logical output to control brake relay.

Indexer Complete Indicates basic indexer sequence in progress or complete. Demo 
mode only.

In Position Drive is at Commanded Position

Table 10-2: Descriptions of Digital Output Commands

Refer to Appendix 1: I/O Timing Diagrams for Input Requirement, System Startup 
Timing, Jog Move Timing, Absolute and Incremental Moves, Timing and Move  
Timing Rules.

Digital Input Control
TMI allows the user to adjust the digital debounce time from 0 to 500 milliseconds. 
(This control is not pictured) 
"Tru-Pneu" Mode check-box executes pneumatic commanded position on power-
up. (By default, drive waits for change in digital input before commencing motion)

10.1.3 Brake Output Configuration
For drives that support brake output, control of the output is configured on the I/O tab.

Figure 10-7: Brake Output enabled

Brake Output Functionality
enable Brake Output Enables or disables the brake output subsystem

Active Low Brake is applied when current is removed

Active High Brake is applied when current is applied
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Brake Output Functionality
Disable Brake Response 
Delay

Number between 0 and 1,000 milliseconds

enable Brake Response 
Delay

Number between 0 and 1,000 milliseconds

Maximum Brake Delay Number between 0 and 1,000 milliseconds

Maximum Brake Velocity Number between 0 and 5 mm/sec.

Table 10-3: Descriptions of Brake Output Functionality

Figure 10-8: Brake Output timing

 NOTe:

The ACSI requires external switching to handle the high amp brake. See ACSI hardware 

manual for details.
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Fault The Fault Tab11
11.1 using the Fault Tab

The Fault tab allows the user to configure how the drive responds to Safety Faults.  
The Critical Faults are always enabled and the configured response is to disable the 
motor.  Critical Faults are listed for information only.

Each of the Safety Fault types has a check-box and a combobox (drop-down).

Figure 11-1: Safety Fault - user defined choices

Each available Safety Fault has 4 different user defined choices. (If greyed out no 
input is configured for that safety fault.) Safety Faults are assigned to physical 
digital inputs in the I/O tab.  If that digital input is High, then the assigned Fault 
condition will occur.

Unchecked Input will not cause a safety fault.
Checked, Stop 
Motion

Fault will result in current motion to stop at Maximum 
Decel value configured on the Safety/Limits tab, and the 
Fault digital output will be turned on.  A subsequent motion 
command may automatically clear this fault.

Checked, Disable 
Motor

Fault will result in drive power to be cut.  If a move is in 
progress, coasting may result.  For a vertical application, the 
load may fall.  The motor will remain disabled until the 
fault is cleared by an ACS Drive Disable/Enable cycle, or 
power cycle.

Checked, Stop 
Motion (without 
Fault Output)

Same as “Checked, Stop Motion” except the Fault digital 
output will not be turned on.

Table 11-1: Safety Fault user defined choices

NOTe: Maximum Decel 

is used in Safety Faults 

when either Stop 

Motion & Stop Motion 

(without Fault Output) 

is chosen. This allows 

a faster motion stop 

than Disable Motor. (See 

Chapter 12 Safety/Limits 

Tab)
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11.2.1 Safety Faults

Safety Faults Table
Positive Limit 
Switch

Fault indicates positive limit has been reached. If Stop Motion is configured, 
the fault will clear on motion in the opposite direction. If Disable Motor is 
configured, the fault is cleared with Disable/Enable cycle.

Negative Limit 
Switch

Fault indicates negative limit has been reached.  If Stop Motion is configured, 
the fault will clear on motion in the opposite direction. If Disable Motor is 
configured, the fault is cleared with Disable/Enable cycle.

Position error Requires motor with an encoder. Fault indicates current position is not within 
the specified Position Error distance (configured on the Safety/Limits tab) 
of the commanded position. If Stop Motion is configured, this fault will be 
automatically cleared on the next move. If Disable Motor is configured, the 
fault is cleared with Disable/Enable cycle.

Stepper Only: If move force < 100% position error reporting on digital fault 
output and fault status is silenced.

Velocity error Velocity is above velocity error max defined in safety limits.

I2T Drive power usage above max allowed. 

Software Stop Fault indicates the signal level on the digital input is high. If Stop Motion is 
configured it will be cleared once the software stop input is lowered. Motion 
will not be allowed until software stop has been cleared. If Disable Motor is 
configured the fault must be cleared by lowering software stop input, and 
cycle enable signal.

Table 11-2: Safety Faults Descriptions

Any Stop Motion commanded by a Safety Fault decelerates the current move at 
max. deceleration (as configured in the Safety/Limits tab).

 
FAuLT NOTe

There is no priority in fault actions. The last fault to occur will perform the 
action associated with it. This is important to understand for troubleshooting 
faults.  For example, if a Software Stop safety fault occurs with the action set to 
"Stop Motion", this will turn on the fault output. And then if a Position Error fault 
occurs shortly afterward with the action set to "Stop Motion without fault output", 
the fault output will be turned off. Another example is if a fault occurs with action 
set to "Disable Motor", and then a fault occurs with action set to "Stop Motion 
without fault output", the result will be the motor stays disabled and the fault output 
is turned off. 

 NOTe: To clear 

faults that disable the 

motor; PLC needs to  

lower/raise the enable 

digital input, toggle 

the enable bit using 

Network or TMI user 

must press the enable 

button on the motion 

manager.

11.2   Fault Descriptions and Recovery
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Figure 11-2: No associated digital input means Safety Fault cannot be configured and are 
displayed greyed out on Fault Tab

11.2.2 Critical Faults
All Critical Faults will disable the motor when they occur. To clear these faults, the 
fault condition cannot be present and the enable input line must be lowered and 
then raised to proceed with motion.  Watchdog timeout must be cleared by power 
cycle only.

Drive Critical Faults Table

Feedback error / motor 
overtemp

Feedback device is malfunctioning OR disconnected when drive is 
enabled. (Power Cycle to Clear) or motor is overTemp

Over Current Drive current is above safe level for the Drive hardware.

Drive Over Temperature Drive temperature is greater than the maximum allowed 
temperature.

Drive Over Voltage Main power voltage exceeds threshold (defined in the hardware 
manual, Input Power Section). 

Drive under Voltage Main power voltage below threshold (defined as 0.6 times 
configured bus voltage).  

Flash error Flash write failed. Flash version doesn't match. 
   • During Startup: Invalid flash version 
   • During Save: Flash write failed 
   • During Motion: Communications error with driver

Short Circuit Motor phase shorted to ground. Internal motor short or phase short 
to ground.

Watchdog Timeout Firmware stall, drive reset or drive power-cycled but voltage did not 
reach ØV. (Power Cycle to Clear) Intermittent power upon startup 
or while running can trigger a watchdog timeout fault. Power 
brownouts may also trigger the watchdog timeout fault.

Table 11-3: ACS Drive Critical Faults Descriptions

 NOTe: To clear 

faults; PLC needs to  

lower/raise the enable 

digital input, enable 

command over network 

control or TMI user 

must press the enable 

button on the motion 

manager.

 NOTe: Critical Faults 

are drive specific. Check the 

hardware manual for more 

information on fault triggers.

  
TROuBLeSHOOTING TIP: 

Short circuit can false trigger if 

Drive power is cut while keep alive 

power is active and the motor is 

enabled and in motion. To prevent 

this, before power is cut, software-

stop (estop) can be commanded 

over I/O or network control. 
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Safety/Limits The Safety/Limits Tab12
12.1 using the Safety/Limits Tab

The Safety/Limits tab is used to configure Safety parameters, Motion Limits and 
setup such features as Endpoint Correction or Zone Output.  

Figure 12-1: Safety/Limits Tab

12.1.1 In Position Criteria
In Position:  This value defines the +/- window around the desired target position 
that is considered within position.

Settle Time:  The amount of time the position is within the In Position Band before 
declaring Motion Complete.

endpoint Correction:  When enabled, Endpoint Correction initiates one correcting 
move at the end of the initial move to correct any position error that is greater than 
the In Position value. At the end of the initial move, the distance of the corrected 
move will be the difference between Target Position and Actual Position. This 
correcting move will use the same motion profile parameters (velocity, accel, decel, 
force) as the initial move. Endpoint Correction is only available with stepper motors 
with encoders.  

Force Move Settle Time:  The amount of time after a specified force is reached 
before declaring Motion Complete.

 NOTE: Throughout this 
manual information that 
ONLY applies to Stepper 
Drives will be noted in grey 
box:

ACS Stepper Drive

Information that applies to 
Servo Drives & ACSI Motor/
Drive will be noted in light 
purple box:
ACS Servo Drive /  
ACSI
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12.1.2 Following error
Position Error: This value defines the +/- window around the commanded position that the 
actual position must be within or a Position Error fault will occur. 

Position Error = Commanded Position – Actual Position. 

The Position Error is continuously calculated throughout the entire move. Position Error is only 
available with motors with encoders. The Position Error setting must always be larger than the 
setting for the In Position parameter. If the Position Error setting is smaller than the In Position 
setting, the In Position parameter will turn red, indicating an invalid setting.

Velocity Error: This value defines the +/- window around commanded velocity that the actual 
velocity must be within or a Velocity Error fault will occur.

Velocity Error = Commanded Velocity – Actual Velocity

Velocity Error is continuously calculated throughout the entire move.  Velocity Error is only 
available with motors with encoders.  By default, Velocity Error output is disabled.  

12.1.3 eco Mode    (Servo / ACSI Only) 
Eco mode is intended to reduce motor current in the motion complete interval (dwell) by 
allowing a slight increase of position error. It is suggested to enable this feature when an I2T 
Fault occurs when the drive is not in motion, or if there is high drag in the mechanical system 
and the drive is near the I2T Limit.

Eco mode is a mode specially designed for instance where the dynamic loads on the actuator 
are lower than the stiction or drag of the mechanical system itself.  In other words, if the drive 
is disabled, the load does not move from its current position.  

In these high drag mechanical configurations, frictional drag may prevent position error from 
ever reaching 0.  As the control loop error increases over time, it eventually breaks through the 
frictional drag and overshoots the target position.  This process repeats and a scenario called 
“Position Hunting” occurs. 

Figure 12-2: Position Hunting in a High Mechanical Drag System

 While this hunting is occurring, current is increasing and, depending on the strength of the 
mechanical stiction of the system, integral error could be spooling up over the continuous 
current limits of the drive or motor.  When the actual current is higher than the continuous 
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current of the motor, an I2T fault can occur, which protects your motor and drive from 
overheating.  If this is occurring, your actual output currents could well be approaching 
the peak limits of the drive or motor.  

When Eco mode is enabled, motion is complete and the current position is within 
the In Position Band, the control loop does not attempt to correct position error.  This 
allows the mechanical advantage of the system to hold the load while the drive 
monitors the position and intercedes when the current position falls outside of the In 
Position Band.  This mode conserves power by stopping the Position Hunt.

Figure 12-3: eco Mode enabled on a High Drag Mechanical System

While Eco mode is primarily used in systems with mechanical high drag, it also can be 
used in systems that do not have high drag, but wish to conserve power – at a cost of 
a slight position adjustment on motion complete.  In these systems, the load pushes 
the Current Position outside of the In Position Band.  The Control Loop then corrects 
the position using a scaling based on target position and the position error limit.  As 
the current position approaches the position error limit the control gains increase.  This 
negotiation results in a rapid equilibrium that conserves power.

Figure 12-4: eco Mode with Position reaching equilibrium

TIPS:   1) The smaller IN Position Band is the less effective ECO Mode, it will be 
reducing power during the motion complete interval.

2) Control gains are scaled at maximum 100% at the position error limit. To reduce 
position error when in motion complete interval, reduce position error limit value.

  

TROuBLeSHOOTING TIP: 

In some Applications, 

if position is pushed 

or forced out of the 

in position band once 

motion completes, the 

position could enter an 

oscillating or waiting 

mode. If this occurs, the 

application is not suitable 

for eco-mode. 
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NOTe: Maximum Decel 

is used in Safety Faults 

when either Stop 

Motion & Stop Motion 

(without Fault Output) 

is chosen. This allows 

a faster motion stop 

than Disable Motor. (See 

Chapter 11 Fault Tab)

12.1.4 Motion Limits
Maximum Velocity:  This value defines the maximum velocity that is allowed to be 
configured by the software and commanded by the ACS Drive. The TMI software will 
automatically cap any entered velocity value to the max setting. When the actuator 
& motor information is entered, the TMI software will automatically calculate the 
Maximum Velocity setting using the actuator max speed and motor max RPM. The 
ACS Drive ensures that no moves can be commanded with a velocity value higher 
than the max setting. This calculation does not include inertia or load. As such, your 
system may not be able to reach maximum velocity.

Maximum Accel/Decel:  This value defines the maximum accelerations and 
decelerations that are allowed to be configured by the software and commanded 
by the ACS Drive. The TMI software will automatically cap any entered value to the 
maximum Accel/Decel setting. The maximum allowable Accel/Decel is 40 times 
the maximum allowable velocity. The ACS Drive ensures that no moves can be 
commanded with an acceleration or deceleration value higher than the value of the 
Maximum Accel/Decel parameter. 

 Note:  If zero (Ø) velocity or accel/decel is entered, these parameters will turn 
red and the Tolomatic logo will appear on the Safety/Limits tab.

12.1.5 Current Limits
Peak Current Max:  Instantaneous current the drive is allowed to supply to the 
motor. This corresponds to 100% force in a move.

Continuous Current Max:  Maximum continuous current the drive is allowed to 
supply the motor.  

Peak Current Duration:  Maximum length of time the drive is allowed to supply 
Peak Current to the motor. This is used for the I2T Fault calculation.  

Holding Current:  This value defines the current level (in percentage) to which the 
ACS Drive sets the output current to the motor when any move is complete. The 
ACS Drive maintains this current level to the motor until the next Move Command 
is executed. The default value for this parameter is 100%. This parameter can be 
used to conserve energy or lower motor temperature while the motor is at rest.

Peak Current Max: This value defines the maximum current applied to the motor 
for all moves. Force % for a move is scaled to this value for any defined Move 
Command in the Mode Setup Tab. The limits are automatically set by the motor 
selection and definition in the Motor Tab.  The value cannot be set higher than the 
maximum rating of the motor/drive combination, but it can be reduced.

  

TROuBLeSHOOTING TIP: 

Choose valid motion limits 

to watch the applcation. 

Max velocity, Accel/Decel 

values that are too high for 

an application can cause 

motion issues including 

possible damage to drives 

in high inertia systems.
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ACS Servo Drive /  
ACSI

12.1.6 Positive/Negative Limits
Software Limits: There are two software limits, a positive and a negative. These 
software limits create a virtual position boundary for the motor/actuator system 
which the ACS Drive can not be commanded to exceed. The exception to this rule 
is for homing. A home command will ignore both software limits and will ignore 
limit switches if move to hard stop is selected. The TMI software will automatically 
cap any move to the positive software limit if the entered value is larger, or to the 
negative software limit if the entered value is smaller. The default values of the 
software limits are dependent upon the following homing sequences:

1. Home to Hard-stop 
Negative home direction:  Positive Software Limit = Stroke – Home Offset;  
Negative Software Limit = - Home Offset

 Positive home direction:  Positive Software Limit = + Home Offset;  Negative 
Software Limit = - Stroke + Home Offset

2. Home to Limit Switch 
Negative Software Limit = - Stroke;  Positive Software Limit = + Stroke 
Note:  The software limits must be changed to restrict motion bounds.

3. Home to Index Pulse (Servo / ACSI Only) 
Motor is configured for rotary mode 
Negative software limit = - Drive max. 
Positive software limit = + Drive max.

Zone Bounds: This feature is only visible if the Zone output is enabled on the I/O 
tab (see Section 10: I/O Tab). There are two zone bounds, a positive and a negative.  
These zone bounds define a virtual position window that is monitored at all times 
by the ACS Drive. When the actual position is greater than or equal to the Negative 
Bound Zone and less than the Positive Bound Zone, the Zone Output will be on. The 
TMI software has rules regarding these zones. The Zone Positive Bound is always 
smaller than the Positive Software Limit but larger than the Negative Software 
Limit. The Zone Negative Bound is always larger than the Negative Software Limit 
but smaller than the Positive Software Limit. The Zone Output feature does not 
interfere with motion. This feature can be used in a variety of applications to prevent  
a collision with another axis of motion or to initiate a process during a specific 
position range.     

Positive
Bound

Positive
Software Limit

Zone Output
ON

OFF

<Negative
Bound

Negative
Software Limit< <

Figure 12-7: Zone Bounds Diagram
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Home Setup The Home Setup Tab13
13.1 using the Home Setup Tab

The Home Setup tab is used to configure the homing routine. Every home routine 
has a configurable motion profile (velocity, accel/decel, force), a choice of direction, 
and an option to home on power-up.

Figure 13-1: Home Setup Tab

Status Bar Indicators have been added to the status bar to indicate when a Fault 
condition exists (red light on the ACS drive flashing) or when the current actuator 
position is within the In Position criteria of the currently programmed software limit.

  • Double-clicking on the Yellow indicator will navigate to the Safety/Limits tab 
so you can review the currently programmed Software Limits and In Position 
Criteria.

  • Double-clicking on the Red indicator will display the Drive Status window.

13.1.1 Method of Homing
There are two different types of homing routines:  

    Homing To Hard Stop

1. With encoder:  This home routine uses the encoder to detect position error to 
find the hard stop during home. 

2. Without encoder:  This home routine initiates an incremental move the size 
of one stroke length. This ensures that the actuator will find the hard stop since 
there is no encoder to help detect it. 

 NOTe: To ensure repeatability it is best to home with relatively slow velocity (<=1"/
sec or 25 mm/sec) and relatively high accel/decel (>40"/sec2 or 1000mm/sec2).

 WARNING: 
Depending on where the 
actuator is positioned 
when homing begins, 
this routine may cause 
the motor/actuator to 
push against the hard 
stop for several seconds. 
This is not ideal for the 
mechanical system and 
may cause audible noise.
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ACS Servo Drive /  
ACSI

Homing to Limit Switch

The To Limit Switch homing routine is only available if the Positive or Negative Limit 
Switch is configured in the I/O tab (see Section 10: I/O Tab). This home routine uses 
either the positive or negative limit switch to find home position. The ACS Drive 
initiates an incremental move the size of one stroke length and stops motion when 
the limit switch input is activated. 

Homing to Index Pulse

The To Index Pulse homing routine is only available if drive is configured for rotary 
operation.

 NOTe: For all homing moves:To ensure repeatability it is best to home with 
relatively slow velocity (<=1"/sec or 25 mm/sec) and relatively high accel/decel (>40"/
sec2 or 1000mm/sec2).

13.1.2 Direction of Motion
Positive or Negative:  Depending on the setup of the motor in the Motor tab (see 
Section 8: Motor Tab), this selection will define the direction the motor/actuator 
system homes.

13.1.3 Motion Profile & Offset   
Velocity to Hard Stop / Limit Switch:  Velocity used in the initial move towards 
the hard stop or limit switch.

Velocity to Offset:  Velocity used when reversing direction to the Offset.

Accel / Decel:  Acceleration and Deceleration setting for all moves in the homing 
routine.

 NOTe: Tolomatic recommends a slow smooth homing Velocity/Accel.  Fast 
homing to hard-stop can damage your actuator.

Offset:  Distance to move away from either hard stop or limit switch in the opposite 
direction selected by Direction of Motion.

Force:  Force % setting for all moves in the homing routine.

13.1.4 Controls
Home: Initiates the Home sequence.

enabled and Homed: Status LEDs.

Position: Indicates current position in user units.

 

  

TROuBLeSHOOTING TIP: 

The motor tab has a 

"reverse direction" check 

box that changes the 

positive direction of a 

motor. use this if home 

direction is changed to 

avoid the requirement to 

use negative positions.
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13.1.5 Additional Settings 
Automatically Home on Power up: This feature homes the system automatically 
when the ACS Drive unit is powered up.  

Automatically Home on enable: Start homing routine when drive is enabled. The 
drive un-homes when the drive is disabled.  

 NOTe:  The Enable input, if configured, must be activated for the  
home routine to start.

 NOTe:  This feature will not work when the ACS Drive is in Network mode 
unless the digital IO enable line is configured and high on power up.

13.1.6 Stop During Homing 
STOP Motion Input: if during homing motion the STOP input is set, it will act like 
a 'home here'. It will decelerate at the homing deceleration value and then reset the 
position to 0.0 and show 'homed' status.

Software STOP input: if during homing the Software STOP input is set, it will stop 
the homing motion and declared 'unhomed' status. The same action will be taken if 
a fault occurs during homing.  

 NOTe: Position is cleared to 0.0 at the hard-stop/limit switch, and again when 
finished the offset move.

DISCONTIN
UED



 ACSI Motor/Drive/Controller User Guide:           TMI Motion Control Interface
 •  53  •ACS Drive: DISCONTINUED Product 05/02/2022 For legacy ACS drive, use this manual for reference only.

Mode Setup The Mode Setup Tab14
The Mode Setup tab is used for configuring the selected mode in the Mode Select 
tab (see Section 9: Mode Select Tab ).

14.1 Index Move Mode
With the Index Move mode, there are three different selections: 4, 8 & 16 Move 
Commands. If the ACS Drive has not been previously configured or it has been 
restored to factory defaults, the Move Commands will be configured with zero 
velocity, accel & decel to prevent any motion. The velocity, accel and decel fields will 
be highlighted in light indicating they are invalid settings (see table below). 

The setup table used for the 4, 8 & 16 Move Commands mode has the following 
columns: Label, Move Type, Position, Velocity, Accel, Decel and Force.  Each individual 
Move Command (rows) can have different, independent settings for each column.  

Setup Table Move Definitions
Label Descriptive alpha-numeric “name” for each Move Command.  Limited to 28 

characters, all uppercase. (Optional, but recommended)
Move Type Drop down selection for the type of move for each Move Command.  Valid selections 

are Absolute (default), IncrPos, IncrNeg, JogPos, JogNeg, Home and No Action.  If an 
encoder is present, all moves are validated with the encoder feedback.  If no encoder is 
present, the move is operated in open loop with no feedback.

Absolute: Initiates an absolute move upon the Start Motion Input.

IncrPos: Initiates an incremental move in the positive direction upon the Start 
Motion Input.

IncrNeg: Initiates an incremental move in the negative direction upon the Start 
Motion Input.

JogPos: Initiates a jog move in the positive direction when the Start Motion Input 
is active. When the Start Motion Input is not-active motion is stopped.

JogNeg: Initiates a jog move in the negative direction when the Start Motion 
input is active. When the Start Motion input is not-active motion is stopped.

Home: Initiates the homing sequence that is defined in the Home Setup tab. The 
position, velocity, accel/decel and force settings in that row will be disabled (not 
used) for this move type.

No Action: Allows user to configure an unused move in the table in order 
to prevent unintended motion. If this move is executed, the ACS Drive will do 
nothing. The position, velocity, accel/decel and force settings in that row will be 
disabled (not used) for this move type.

ACS Servo Drive / ACSI Motor/Drive/Controller
Force: Allows user to configure a push to force move upon start motion input. 
(see Force Move Settle Time, 12.1.1)

*IncPosRotary: Initiates an incremental move in the positive direction.  If the end 
of stroke will be reached before the move completes its trajectory, the position is 
reset and the drive is un-homed.  This allows for infinite incremental moves in the 
same direction.

*IncNegRotary: Initiates an incremental move in the negative direction.  If 
the end of stroke will be reached before the move completes its trajectory, the 
position is reset and the drive is un-homed.  This allows for infinite incremental 
moves in the same direction.

ACSI Motor/Drive/Controller

 NOTe:

8 & 16 Move Commands are 

not available with ACSI Motor/

Drive /Controller

 *NOTe: 
When position is reset, a slight 
loss in precision occurs. Over 
time, this could manifest itself in 
positional drift. It is recommended 
to periodically reset position using 
a home to Index Pulse or home to 
Limit Switch to prevent this from 
causing issues.
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Setup Table Move Definitions
Move Type

(cont.)

VelocityFwd: Initiated a velocity move in the forward direction with no positional 
control.  At the end of the move, the actual position will be reset and the drive is 
un-homed.  If Servo drives are used, configure Velocity Feed Forward to 
100% (Tuning Filter)
VelocityRev: Initiated a velocity move in the reverse direction with no positional 
control.  At the end of the move, the actual position will be reset and the drive is 
un-homed.  If Servo drives are used, configure Velocity Feed Forward to 
100% (Tuning Filter)
NOTe: See Start Motion Input (see Appendix 1: Timing Diagrams)

Position Move position value for either absolute or incremental moves.  This field is not 
used in Jog, Home, or Velocity move types.

Velocity Velocity value for all move types
Accel/Decel Acceleration and Deceleration value for all move types
Force % Force % value from 10 to 100% for all move types. 

ACS Stepper Drive
If force <100% and a position error condition occurs  
(motors with encoders), the fault action will be executed but the fault will not 
be reported.

Table 14-1: Descriptions of Setup Table Move Definitions for 4, 8, and 16 Move Commands 

 Commands. If the ACS Drive has not been previously configured or it has been res
Figure 14-1: Mode Setup– 4 Move Commands, Not Configured
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Figure 14-2: Mode Setup– 8 Move Commands, Not Configured

Figure 14-3: Mode Setup– 16 Move Commands, Not Configured

 NOTe: The 

software controlled 

MS# LeDs will light 

to indicate what 

digital input pattern 

corresponds to that 

row. Similarly, you 

can use the mouse to 

click and toggle the 

MS# LeDs On/Off and 

the row corresponding 

to that binary code will 

be selected. DISCONTIN
UED
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 NOTE: Default Move Command velocities, acceleration, and deceleration are 0. 
If user does not configure a valid value for all motion parameters the TMI software 
and the ACS Drive will not allow that move to be executed.

For the move types of Home and No Action the fields for Position, Velocity, Accel, 
Decel and Force do not apply. They appear grey and are disabled for these move 
types. 

With Home move type the parameters used in the homing routine are from the 
Home Setup tab. Using a Home move type in the Index Move table allows the user 
to free up an additional digital input. 

The No Action move type is used to prevent unwanted moves from being 
commanded. If this type is configured, the controller will simply do nothing when it 
is commanded to move to that move number.

Figure 14-4: Mode Setup– The Home & No Action commands disable several fields.

14.1.2 editing, Arranging and Testing Move Commands
Once all the Move Commands have been configured, there are several features 
in the Mode Setup screen for editing, arranging, or testing the configured Move 
Commands.

Move Row  up / Down:  Move the Move Commands up and down one 
row at a time in the table.  

 

Copy / Paste / Cut  Row:  Copy, Paste & Cut functionality for each row.  
Select the row and click button for desired functionality.  

Teach:  Teach all motion profile parameters (position, velocity, accel/
decel, force) from the Motion Manager (see Section 15: Motion 
Manager Tool) into the selected row in the table. If the selected row 
already has valid data, the TMI will prompt the user whether they want 

to overwrite it or not. If the ACS Drive is disabled (See Motion Manager) pressing 
teach will only update the position (not Velocity/Accel/Decel or Force). This is useful 
for manually positioning the actuator then teaching that position.
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execute Move:  Clicking this button will execute or start the selected 
move in the table.  The selected move is denoted by the move 
highlighted in blue with the black arrow on the left hand side.  For Jog 
moves, the move is initiated while the Execute Move button is pressed 
and will stop when the Execute Move button is released.  

Motion Manager:  Opens and closes the Motion Manager tool (see 
Section 15: Motion Manager Tool)

    

Write Flash:  Write Current Settings to Drive Flash:  Write all 
parameters from the TMI software into the drive flash memory.

Launch Indexer:  Opens the Basic Indexer Configuration Tool window 
(Demo Mode Only)

Software Controlled:  When the TMI is in Software Control, all motion commands 
(Start Motion and Home inputs) from the I/O interface (PLC or logic controller) are 
ignored. In order to test the I/O logic with the PLC or logic controller, the user must 
select Digital Input Controlled. 

While in Software Control, the user can test the moves by using the Software 
Controlled Move Test Sequence. This feature allows up to 16 Move Commands to 
be tested in any order. When in Software Controlled mode, the Move Select (MS#) 
LEDs in the Digital Input Controlled group box will echo the logic of the selected 
Move Command in the table. The Software Controlled mode feature has the 
following controls: 

Figure 14-5: Software Controlled user Options

Add:  Click Add to add a Move Command to the next available position.

  

Reset:  Removes all Move Commands from the test sequence

Play:  Initiates the test sequence.  All Move Commands in sequence will be 
executed once.

Stop:  Stops the test sequence.

 NOTe: Jog and 

No Action moves as 

well as empty boxes 

will be skipped when 

playing the sequence.
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Pause:  Pauses the test sequence on the highlighted move.

Step:  Steps through the test sequence one Move Command at a time.

Cycle Continuously: When this feature is checked, the  test sequence cycles 
continuously in an endless loop until the Stop or Pause button is clicked, the user 
switches to the Digital Input Controller, navigates to another tab, or communication 
is disconnected.

When the test sequence is in progress:

1. All other move controls in Mode Setup and Motion Manager will be disabled.

2. The currently executed move will be highlighted in blue in the table.  

Move Delay: User settable dwell between test sequence moves. (Not Pictured) 

Digital Input Controlled:

In order to test the I/O logic with the PLC or logic controller, the user must select 
Digital Input Controlled. When in this mode, all move buttons in the software are 
disabled and motion can only be initiated from the logic controller (PLC).  The 
selected move from the Move Select inputs (see Section 10: I/O Tab) will be 
highlighted in blue in the table below. The Move Select (MS#) LEDs in the Digital 
Input Controlled group box will echo the logic of the Move Select inputs from the 
physical I/O interface. In this mode, the PLC or logic controller can select the 
desired move using the Move Select inputs and initiate motion using the Start 
Motion input (see Appendix 1: Timing Diagrams). 

 

Figure 14-6: Digital Input Controlled

 NOTe: When Software Controlled is selected the MS1 to MS4 “LEDs” will track 
the selected line in the Move Definitions table.DISCONTIN

UED
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Figure 14-7: Configured Mode Setup, 16 Move Command Mode

14.1.3 FORCe Move Type
The FORCE move type is similar to the ABSOLUTE position move but with additional 
logic added to help with press at force applications. For safety of the user and 
equipment, the FORCE move is run as a position move in the way that it uses the 
position, velocity, and current control loops as opposed to other servo drives that 
only use the current loop for a force move. The advantage to using all three loops 
is to have control over the actuator speed; speed is not controllable with current 
loop only implementations. The current loop has a limiter at the input to limit the 
maximum current to the value of the move FORCE % as setup in each move’s 
profile. A position command past the point of press may be desired to reach this 
desired force.

Important notes about the Force move behavior:

   • The Force Move Settle Time is a timer that starts counting when the Force % 
has been reached, and ends when the Force Move Settle Time in milliseconds 
has passed. This timeout will set the motion complete output to ON and another 
move may be commanded. If the Force % has not been reached then the Force 
Move Settle Time starts when the move trajectory completes. 

   • It is recommended that the next move after a FORCE move that releases the 
press also be a Force move with the same Force %. This will ensure smooth 
force transitions and prevent unwanted jumps or spikes in force as well as 
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prevent position error fault from triggering. 

   • Position error Fault is disabled during Force moves.

   •  WARNING: If a press move has reached its Force % and the load 
is suddenly removed, the actuator may accelerate quickly toward the 
commanded position at an un-regulated speed. This is due to the large 
position error and the proportional integral gains trying to compensate for the 
error. 

The following examples shows a force move where an actuator presses into a 
spring fixture until a force is achieved. The only difference between the two scope 
captures is the Force Move Settle Time.

  
Figure 14-8: entries for Force Move

Figure 14-9: Force Move Settle Time set to 100 msec 

Figure 14-10: Resulting Motion Profile, 100 msec Settle Time

 1. Force move begins (Press move)

 2. Actuator begins compressing a spring
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UED
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 3. Actuator reaches Force % value, Force Move Settle Time timer begins

 4. Force Move Settle Time

 5. Motion Complete signaled

 6. Start new Force move (Release move) to back off of the spring.

 7. Move complete, motion complete will be signaled after Force Move Settle Time. 

Figure 14-11: Force Move Settle Time set to 1000 msec 

Figure 14-12: Resulting Motion Profile, 1000 msec Settle Time

 1. Force move begins (Press move)

 2. Actuator begins compressing a spring

 3. Actuator reaches Force % value, Force Move Settle Time timer begins

 4. Force Move Settle Time

 5. Motion Complete signaled

 6. Start New Force move (Release move) to back off of the spring. 

 7. Move complete, motion complete will be signaled after Force Move Settle Time. 
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14.2 Basic Indexer (Demonstration Mode)
The Basic Indexer is an onboard sequencer used for demonstrations that allows 
users to set up a series of moves that be initiated by a digital input.  It is an 
Index Move operating mode.  It uses the existing Move Definitions table to store 
motion profiles as well as a sequence definitions table that stores the configured 
sequences.  To configure a sequence, the user must use both tables in tandem.  To 
launch the Basic Indexer, click the “Launch Indexer” button on the Mode Setup tab.  

Figure 14-13: Indexer Configuration

Tool Name Description
Reset 
Selected

Resets and removes the currently selected sequence

Reset All Resets all sequences in the table
Import From 
Mode Setup

Imports a sequence from the Software Controlled Move Test Sequence tool on 
the Mode Setup Tab into the currently selected element (overwriting the existing 
element definition)

export To 
Mode Setup

Exports a sequence starting at the currently selected element to the Software 
Controlled Move Test Sequence Tool on the Mode Setup Tab. 

View as 
Sequence 
Diagram

Launches a Sequence Diagram window that starts at the selected element and 
displays the progression of the sequence.  If the sequence is currently being run 
on the drive, it will also indicate the running element

Play From 
Index

Starts a visual sequence that slowly plays through the selected sequence (Not 
this does not command motion.  For commanding motion, use the Test Sequence 
Tool on the Mode Setup tab)

Stop Play Stops the Play From Index function
Hide Inactive Hides all undefined elements in the Sequence Definitions table
Show All Un-hides all undefined elements in the Sequence Definitions table
Add element Adds an undefined element to the Sequence Definitions table
Digital Input 
Feedback

In software control, selecting a MSX LED will select the defined entry point for 
the given combination of Move Selects.  Move Select (MS) inputs are configured 
on the I/O tab.  In Digital Input Control, these LEDs will turn on and off based on 
Move Select Input status.  In Software Control, the LEDs can be pressed to show 
which Digital Input Entry Point is valid for the Move Select inputs

elements

There are 2 types of elements – Digital Input Entry Points and standard elements.  

Digital Input entry Points occupy the first two (2) or more elements in the 
sequence definitions table (based on the number of configured Move Select lines in 
the I/O configuration.  Each Entry Point corresponds to a Move Select combination. 

 
Figure 14-14 Digital Input entry Points

Digital Input Entry Points each have a unique color associated with them that allows 
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users to quickly identify which elements belong to which sequences.  Elements can 
belong to multiple sequences.  

A standard element does not have a unique color associated with it and can be 
assigned to multiple sequences.  On the right side of each element, the Element 
Flag indicates the Digital Inputs the element is assigned to.    The element 3 ion 
the following example is part of both Digital Input Entry Point 1’s and DIEP 2’s 
sequences.  

Figure 14-15 Standard elements

The Move Definition combobox allows the user to select which Move Definition 
(defined in the Mode Setup tab) the element executes when active.  For ease of 
use, label each move definition uniquely to help designate the definition in the 
Indexer Configuration tool.

Figure 14-16 Move Definition combobox

Sequence Diagram

The Sequence Diagram is a tool that allows one to visualize a Basic Indexer 
sequence.  The user clicks on the starting element of the sequence to visualize and 
then clicks on the “View as Sequence Diagram” icon.  

Figure 14-17 Click on the view as Sequence Diagram iconDISCONTIN
UED
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Figure 14-18 Sequence Diagram

In this example, the sequence is linear, starting at Element 1 and finishing at 
Element 7.  Once Element 7 is complete, the Indexer is complete.  

Figure 14-19 Sequential Graph

The way to indicate the end of a sequence is to set the Next Element equal to the 
current element.  In this case Element 7’s next element is Element 7.  If instead 
the user would like this sequence to continue indefinitely (while the Digital Inputs 
are valid), the user can change Element 7’s Next Element to another element in the 
sequence.  
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Figure 14-20 Sequence Diagram

In this example, Element 7’s Next Element is Element 3.  To visualize this, the user 
executes the “View Sequence Diagram” tool.  From this, it is apparent that Element 
1 is the starting point and is executed once, but the rest of the elements form a 
circular queue that is continuously executed while the Digital Inputs are valid for 
Entry Point 1.  

Figure 14-21 Sequential Graph

With the Sequence Diagram open, selecting an Element in the Indexer Configuration 
will highlight the corresponding Element in the Sequential Graph.

Running Indexer in Digital Input Control
When running the Basic Indexer in Digital Input Controlled mode 

Figure 14-22 Digital Input Control Mode
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The Indexer Configuration tool will provide feedback about the current running 
sequence.  The Digital Input Entry Point that is currently being executed (by the 
configured Move Select lines) will be highlighted blue.  The currently executed 
Element will be selected, and the Next Element in the sequence will have a black 
box around the Element.  See below

Figure 14-23 Digital Input entry

Digital Input Entry Point 1 is being executed (Move Select 1 digital input is low).  
The Element that is currently being executed is Element 3, and the next element 
that will be executed is Element 4.  

The Sequence Diagram tool will also provide feedback during Digital Input Control.  
The Element currently being executed will be highlighted with a white circle.  As the 
sequence progresses, each element will be highlighted as it is executed. 

Figure 14-24 Sequential Graph

 NOTe: For demos, the 

Indexer can be configured 

to start on power up 

without digital input 

control. A check-box for 

this is on the I/O Tab.
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ACS Stepper Drive

ACS Servo Drive / 
ASCI

14.3 Pneumatic Mode
Pneumatic mode is used to replace or replicate pneumatic cylinder/valve operation 
logic.  With pneumatic mode, there are four different selections:  Spring, 2 Position 
(2 input), 3 Position (2 input) & 3 Position (3 input).  These four pneumatic mode 
operations allow almost any pneumatic valve logic to be replaced with the ACS 
drive.  Additionally, in pneumatic mode, the drive will automatically home the 
actuator upon power up based on the home setup configuration.  

 NOTE: The default configuration for Pneumatic Mode automatically enables 
drive upon power up. Because of this, the only way to clear a fault is to cycle power 
unless the enable input is configured to a digital input in the I/O tab.

The setup table used for pneumatic mode has the following columns:

Setup Table Move Definitions
Label Descriptive alpha-numeric “name” for each Move Command.  Limited to 28 

characters, all uppercase.

Move Type Absolute: Initiates an absolute move upon change of Move Select bits. (STEPPER 
DRIVE: Pneumatic Mode only supports Absolute Moves)

Absolute: Initiates an absolute move upon change of Move Select bits. (SERVO 
DRIVE: Pneumatic Mode supports Absolute and Force Moves)

Position Move position value for absolute moves.  This field is not used in JogPos or 
JogNeg move types.

Velocity Velocity value for all move types

Accel/Decel Acceleration and Deceleration value for all move types

Force % Force % value from 10 to 100% for all move types.

Table 14-2: Descriptions of Setup Table Move Definitions for Pneumatic Mode 

 NOTE: Default Move Command velocities, acceleration, and deceleration are 0. 
If user does not configure a valid value for all motion parameters the TMI software 
and the ACS Drive will not allow that move to be executed.

Figure 14-25: Pneumatic, Spring

  
TROuBLeSHOOTING TIP: 

Pneumatic Mode by default 

is edge triggered. This means 

the motion will only occur 

when a change in digital input 

is detected. If user requires 

the drive to command move 

immediately on power up, check 

the "Tru-Pneu" mode check-box 

on the I/O Tab. 
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Figure 14-26: 2 Position (2 input)

Figure 14-27: 3 Position (2 input)

Figure 14-28: 3 Position (3 input)
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Digital Input Controlled:

In order to test the I/O logic with the PLC or logic controller, the user must select 
Digital Input Controlled. When in this mode, all move buttons in the software are 
disabled and motion can only be initiated from the logic controller (PLC).  The 
selected move from the Move Select inputs (see Section 10: I/O Tab) will be 
highlighted in blue in the table below. The Move Select (MS#) LEDs in the Digital 
Input Controlled group box will echo the logic of the Move Select inputs from the 
physical I/O interface. In this mode, the PLC or logic controller can select the 
desired move using the Move Select inputs and initiate motion using the Start 
Motion input (see Appendix 2: Pneumatic Mode - Move Select Logic Table).

 

Figure 14-29: Digital Input Controlled

14.4 Analog Position Mode
14.4.1 Configuring Analog Position Mode

Analog Position mode is used to equate an analog input voltage or current to 
position.  The ACS Drive will convert the analog input to a scaled position range.  If 
the ACS Drive has an analog output installed, the position of the encoder will be 
scaled to the analog output.  If the ACS Drive has not been previously configured for 
Analog Position mode or has been restored to factory defaults, the Analog Position 
mode will be configured with zero Min/Max Position, Velocity, Accel/Decel to prevent 
any motion.  The Min/Max Position, Velocity, Accel/Decel fields will be highlighted in 
light red indicating they are invalid settings (see Figure 14-18 below).

Figure 14-30: Default Analog Position Mode for Voltage

 NOTe: When 
Software Controlled is 
selected the MS1 to 
MS3 “LEDs” will track 
the selected line in the 
Move Definitions table.
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The mode setup for Analog Position mode has the following parameters that must 
be configured for proper operation.

Min/Max Voltage or Current:  The range of Voltage is 0 to 10VDC and the range 
of Current is 4 to 20mA.  

Min/Max Position:  The configured positions that are equated to the Min/Max 
Voltage or Current setting.  The ACS Drive will then linear interpolate the Analog 
Input and equate it to position based on the Min/Max Voltage or Current settings 
along with the Min/Max Position settings.  

Velocity:  Velocity value for any Analog Position move

Accel/Decel:  Acceleration and deceleration value for any Analog Position move

Force:  Force % value from 10 to 100% for any Analog Position move

Deadband:  Plus / Minus window for Analog Input that is ignored or not used to 
create motion.

Position update Rate:  This setting adjusts the rate at which position commands 
are updated based on the changing Analog Input.  A slower setting means the 
response of the system will not be as dynamic.  A faster setting means the system 
will respond more quickly

Figure 14-31: Settings for Analog Position mode for Voltage

Relationship between Analog Mode & Start Motion Input:  

1. If Start Motion Input is configured in I/O Tab then user must set the Start 
Motion input ON to get motion. If Start Motion is configured and is set to OFF, 
user will not get motion after adjusting analog input.

2. In I/O Tab unmapping Start Motion input relieves the responsibility of setting 
Start Motion input to get motion using Analog input.

VOLTAGE/CURRENT

PO
SI

TI
ON

(Vmin, Pmin)

(Vmax, Pmax)
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 NOTe:  If the Analog Output option is not installed, the Output slider will not be 
visible.  

 NOTe:  If the motor doesn't have an encoder, the analog output will be forced 
to 0 (volts or mA) and not used. 

In the example above:

 0 volts = 0 inch position

 10 volts = 4 inch position

All moves will move with 3 inch/sec velocity, 10 inch/sec2 accel/decel and 100% 
force.

14.4.2 Simulating the Analog Position Input
To simulate the analog input and test the logic setup for Analog Position mode, click 
on the Simulate Analog Input check-box. This will disable all the Analog Position 
Setup variables and the calibrate Analog I/O button because changes are not 
allowed when attempting motion.  There are two sliders in the Test Analog Position 
box:  one for an Input and one for the Output.  The Input is enabled and the user 
can change the values of the simulated analog input to create motion.  The output 
slider should mimic the value of the analog output based on the actual position, if 
the motor has an encoder.

Figure 14-32: Simulating Analog Input

 NOTe: When Simulate Analog Input is not checked, the output slider may be moved 

to manually change the analog output of the ACS drive. 

 NOTe:  
When simulating 
Analog Input, the 
Motion Manager 
tool is disabled.  
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14.4.3 Analog Input Controlled Position
Analog Input Controlled is used to test the logic of the Analog Position mode setup 
with actual external hardware such as a PLC.  When the Analog Input Controlled 
button is pressed, the message below will be displayed.  

WARNING:  If “Yes” is selected, the user should expect motion as the ACS Drive will 
attempt to move in accordance with the Analog Position Setup.  

Figure 14-33: Confirm motion warning window

Once in this mode, the PLC or external Analog source can be used to test the 
system.  

Figure 14-34: Analog Input Controlled

14.4.4 Calibrating Analog Input & Output
For advanced applications where positional accuracy is extremely important, the 
Analog I/O Calibration tool can be used to calibrate both the Analog Input and 
Output.  Press the Calibrate Analog I/O tool from the Mode Setup screen to launch 
the tool. Once in Analog I/O Calibration, the user cannot navigate to any other 
screens in the Tolomatic Motion Interface (TMI).  The user must click the Calibrate 
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Analog I/O check box to enable the calibration process. 

For analog input calibration, a voltage or current source and a multimeter will be 
required.  Input a voltage or current to the ACS Drive and measure with the meter.  
Enter that value into the Measured Input field and press the associated Calibrate 
Min or Max button.  For voltage, the recommended ranges are 1-4 volts for the Min 
voltage and 6-10 volts for the Max voltage.  For current, the recommended ranges 
are 2-8 mA for the Min current and 12-20 mA for the Max current.  

The analog input also has a software filter that is adjustable to give flexibility to the 
user on how dynamic the Analog Position control should be.  With a filter setting 
more towards Min, the analog filter will do less filtering and the controller will follow 
closer to the actual analog signal including signal noise.  With a filter setting more 
towards Max, the analog filter will do more filtering causing the analog input signal 
to the controller to be smoother (less noisy).  

For analog output calibration, a multimeter will be required.   Enter a Min voltage 
or current  (1 - 4 volts or 2 - 8mA) into the Test Output field press Test Min and 
then measure with the meter.  Enter the measured value into the Measured Output 
field and press Calibrate Min button.  Repeat procedure for Max voltage or current 
(6 - 10 volts or 12 - 20mA) and press the Calibrate Max button. Click OK button to 
send the calibrations to the ACS drive.

Figure 14-35: Sample of completed Analog I/O calibration
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14.5 Analog Velocity Mode (Rotary Only)
14.5.1 Configuring Analog Velocity Mode

Analog Velocity mode is used to equate an analog input voltage or current to 
velocity.  The ACS Drive will convert the analog input to a scaled velocity rate.  If the 
ACS Drive has an analog output installed, the velocity of the encoder will be scaled 
to the analog output.  If the ACS Drive has not been previously configured for Analog 
Velocity mode or has been restored to factory defaults, the Analog Velocity mode 
will be configured with zero Min / Max Velocity, and Accel / Decel to prevent any 
motion.  The fields will be highlighted in light red indicating they are invalid settings.  
(See Figure 14-36 below).

Figure 14-36: Invalid settings are highlighted in light red

The Mode Setup tab for Analog Velocity mode has the following parameters that 
must be configured for proper operation.

Min/Max Voltage or Current: The range of Voltage is 0 to 10VDC and the range 
of Current is 4 to 20mA.

Min/Max Velocity: The configured velocities that are equated to the Min/Max 
Voltage or Current setting.  The ACS Drive will then linear interpolate the Analog 
Input and equate it to velocity based on the Min/Max Voltage or Current settings 
along with the Min/Max Velocity settings.

Accel/Decel: Acceleration and deceleration value for any Analog Velocity move

Force: Force % value from 10 to 100% for any Analog Velocity move
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Deadband: Plus / Minus window for Analog Input that is ignored or not used to 
create motion

Velocity update Rate: Adjusts the rate at which velocity commands are 
updated based on the changing Analog Input.  A slower setting means the 
response of the system will be buffered.  A faster setting means the system will 
respond more quickly

Figure 14-37: Invalid settings are highlighted in light red

Settings for Analog Velocity mode for Voltage

Relationship between Analog Mode & Start Motion
1. If Start Motion Input is configured for I/O Tab, then user must set Start Motion 

input HIGH to initiate motion.  If Start Motion is configured and is set LOW, user 
will not get motion after adjusting analog input.

2. In I/O Tab, unmapping Start Motion input relieves the responsibility of setting 
Start Motion input to initiate motion using analog input.

 Note: If the Analog Output option is not installed, the Output slider will 
not be visible

 Note: If the motor does not have an encoder, the analog output will be 
forces to 0 (volts or mA) and not used

DISCONTIN
UED



 ACSI Motor/Drive/Controller User Guide:           TMI Motion Control Interface
 •  76  •ACS Drive: DISCONTINUED Product 05/02/2022 For legacy ACS drive, use this manual for reference only.

T H E  M O D E  S E T U P  T A BMode Setup

14.5.2 Simulating Analog Velocity Input
To simulate the analog input and test the logic setup for Analog Velocity mode, click 
on the Simulate Analog Input checkbox.  This will disable all the Analog Velocity 
Setup variables and the calibrate Analog I/O button as changes are not allowed 
when making motion.  There are two sliders in the Test Analog Velocity box: one for 
Input and one for Output.  The Input is enabled and the user can change the values 
of the simulated analog input to create motion.  The output slider should simulate 
the value of the analog output based on the actual velocity, if the motor has an 
encoder.  

Figure 14-38: Simulating Analog Input

 Note: When Simulate Analog Input is not checked, the output slider 
may be moved to manually change the analog output of the ACS DriveDISCONTIN
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14.5.3 Analog Input Controlled Velocity
Analog Input Controlled is used to test the logic of the Analog Velocity mode setup 
with actual external hardware such as a PLC.  When the Analog Input Controlled 
button is pressed, the message below will be displayed

 WARNING: If “Yes” is selected, the user should expect motion as the ACS Drive will attempt to 
move in accordance with the Analog Velocity setup.

Figure 14-39: Confirm motion warning window

Once in this mode, the PLC or external Analog source can be used to test the 
system

Figure 14-40: Test with PLC or external Analog source

14.5.4 Calibrating Velocity Analog Input & Output
See Section 14.3.4 Calibrating Input & Output
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14.6 Network Mode
14.6.1 using Network Mode

Once the ACS Drive has been configured for the desired Actuator and Motor, 
Network mode can be configured for control with drive specific protocols.  
Depending on the model ordered, the TMI software will only show its configured 
protocol. In this section Network refers to all protocols

When Mode Select is configured for Network operation, the Mode Setup tab will allow 
setup of up to 16 moves.  The Network Move GroupBox displays the most recently 
commanded move.  Please note that the Current Position is displayed instead of the 
Position from the move table or the position sent over the network.  The reason for 
this is to be able to track the absolute position at all times.  Move number 0 indicates 
a move commanded by the TMI Motion Manager or the Network connection. 

When the TMI user presses the Network Controlled radio button, control indicator 
(as seen on the Drive Status Tool) will turn off and the TMI controls will be disabled.  
This keeps the TMI user from changing parameter values while the network 
controller is commanding movement.

When Network is in control, the controls in the Mode Setup tab’s Network Move 
GroupBox show the most recent move commanded by the PLC master.  Note that 
rather than displaying the commanded position, the Current Position is displayed.

To return control to the TMI host, either press the Software Controlled radio button, 
or select one of the tabs other than Mode Setup.

The Host in control indicator on the Drive Status tool indicates whether TMI (the 
Host in this case) is in control.

ACS Stepper Drive

ACS Servo Drive / ACSI

Figure 14-41: Drive Status tool indicates Software (Host) is in control.

 NOTe: The 

TMI software 

will determine 

which protocol is 

appropriated based 

on the ACS unit 

connected.

 NOTe: To setup 

ACS drive for Network 

communication, the 

ethernet port must 

be configured using 

the ethernet Setup 

Tool. See Section 

21 for details. Some 

protocols require 

configuration over 

network control. 

This is called 

"Infrastructure 

Mode".

 NOTe: 

Details about 

communications with 

drive over Network 

Mode can be found in 

the protocol specific 

document, accessible 

via the Help menu.
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Figure 14-42 PLC Master in control, last commanded move is highlighted.

14.6.2 Behavior of network commands and configured 
     digital inputs

eNABLe COMMAND

MODe SeLeCT
DIGITAL  
INPuT  
STATe

NeTWORK 
COMMAND 

STATe
ACTION

"Network" 0 0 DISABLE

"Network" 0 1 DISABLE

"Network" 1 0 DISABLE

"Network" 1 1 ENABLE

INDEX 0 X DISABLE

INDEX 1 X ENABLE

ANALOG 0 X DISABLE

ANALOG 1 X ENABLE

PNEUMATIC 0 X NOT AVAILABLE 

PNEUMATIC 1 X NOT AVAILABLE

SOFTWARE  
CONTROLLED  

(HOST IN CONTROL)
X X ONLY TMI CONTROLS  

ENABLE

Table 14-3: enable Command modes and actions when digital input is  
configured to enable.
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SOFTWARe STOP COMMAND (e Stop)

MODe SeLeCT DIGITAL IN-
PuT STATe

NeTWORK 
COMMAND 

STATe
ACTION

"Network" 0 0 SOFTWARE STOP OFF

"Network" 0 1 SOFTWARE STOP ON

"Network" 1 0 SOFTWARE STOP ON

"Network" 1 1 SOFTWARE STOP ON

INDEX 0 X SOFTWARE STOP OFF

INDEX 1 X SOFTWARE STOP ON

ANALOG 0 X SOFTWARE STOP OFF

ANALOG 1 X SOFTWARE STOP ON

PNEUMATIC 0 X SOFTWARE STOP OFF

PNEUMATIC 1 X SOFTWARE STOP ON

SOFTWARE  
CONTROLLED  

(HOST IN CONTROL)
0 X SOFTWARE STOP OFF

SOFTWARE  
CONTROLLED  

(HOST IN CONTROL)
1 X SOFTWARE STOP ON

Table 14-4: Software Stop Command modes and actions when digital input configured to 
Software Stop.
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Motion Manager Tool15
15.1 using the Motion Manager

The Motion Manager allows the user to enable/disable the motor, home, and create 
simple motion commands (Absolute, Incremental, Jog). The Motion Manager is a 
can also be used for positioning in order to teach Moves into the Mode Setup table 
(see Section 14: Mode Setup Tab).

Figure 15-1: Launching the Motion Manager Tool

15.1.1 Controls
enable/Disable: Enables or Disables drive and output to motor.

Home: Initiates Home sequence configured in Home Setup Tab.

enabled, Homed, Motion Complete LeDs: Status LEDs.

15.1.2 Motion Profile
Position: Displays actual position from encoder or commanded position without 
encoder. Motion profile (Velocity, Accel, Decel, Force) per Jog, Absolute and 
Incremental moves in Motion Manager.

Velocity: Profile Velocity to execute

Accel: Profile Acceleration to execute

Decel: Profile Deceleration

Force: Profile Force

 WARNING: Before 
making a move with 
the Motion Manager 
verify Velocity, Accel, 
Decel, Force, Bus 
Voltage (Servo), and 
Inertia (Servo).
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15.1.3 Jog
Jog Neg: Initiates a Jog Move with motion profile settings in a negative direction.

Jog Pos: Initiates a Jog Move with motion profile settings in a positive direction.

 NOTe: Jog move will be initiated while Jog Neg or Jog Pos button is held down 
by mouse click. The jog move will stop when the mouse click is released.

Figure 15-2: Motion Manager Panel

15.1.4 Absolute Move
Initiates an absolute move to entered position parameter with motion profile 
settings.

15.1.5 Incremental Move
Incr Neg: Initiates an incremental move the size of the entered distance parameter 
in a negative direction.

Incr Pos: Initiates an incremental move the size of the entered distance parameter 
in a positive direction.

15.1.6 Stop
Stops currently executing motion at profile deceleration.

 NOTe: executing 

a "Stop Motion" 

during homing will 

stop motion and 

declare current 

postion "Home".
DISCONTIN
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Tuning Filter Tool16
Tuning a servo motor is an advanced procedure.  Tolomatic standard motors have 
predetermined tuning values that should work for most applications. Tuning should 
be performed when more performance is required for the application or when a new 
motor is added. A basic understanding of PI (Proportional Integral) Control Loops is 
required for tuning.

The Servo Control Loop for Position Control is made up of three separate PI loops: 
Position, Velocity, and Current loops. These three control loops are cascaded, 
meaning that the output of one loop feeds into the input of the next loop. The 
position loop uses profile position from the trajectory generator and actual position 
from the feedback device to commanded velocity.  The velocity loop uses the sum 
of commanded velocity from the position loop and profile velocity and compares 
it to actual velocity to generate a commanded current.  This commanded current, 
along with the actual current, is used to control the PWM to the bridge circuit which 
in turns drives the servo motor.  

Figure 16-1: Control Loop

Each control loop corresponds to a set of tunable parameters in the Tuning Filter.

DISCONTIN
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16.1 Tuning Filter Dialog
The Tuning Filter tool is broken into two distinct parts – the Parameter Adjustment 
pane, and the Graphing Pane.  The parameters are adjusted in the left hand side of   
the window, and the effects can be observed on the right hand side of the window.

  
Figure 16-2: Tuning Filter Dialog

16.1.1 Parameter Adjustment Pane
   • Bus Voltage: Bus voltage of the system, typically 24V or 48V. Note: This setting 

affects the calculation of current loop gains.

   • Reflected Inertia Match: Inertia match of the system.  Note: This setting affects 
the calculation of velocity loop gains.

   • High Friction: Gains Amplifier to be enabled for systems with high friction or 
drag forces that affect motion.

   • Proportional Bandwidth: Proportional bandwidth value for the given PI loop 
(Position, Velocity, Current) used to calculate proportional gain. The value can 
be changed using the numeric up/down box or by clicking on the graph.

   • Integral Bandwidth: Integral bandwidth value for the given PI loop(Position, 
Velocity, Current) used to calculate integral gain. The value can be changed 

 NOTe: Feed 

forward should be set 

to 100% for velocity 

moves. DISCONTIN
UED
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using the numeric up/down box or by clicking on the graph.

   • Feed Forward: Percentage value that enables the profile velocity command to 
help drive the velocity loop in addition to position error.

   • Err Sum Max: Percentage value that can be used to limit the amount of error 
calculated in the loop. Useful in limiting runaways and over corrections.

   • Filter Frequency: Used to control velocity output filter (Hz), a smaller value will 
smooth the output.

   • Filter Resonance: Used as input to velocity output filter (Hz).

   • Save to Flash: Saves the tuning settings of the specific loop to internal storage 
on the drive so that it can be maintained when the system power cycles

   • Test Move: Configures the drive for a continuous sequenced position move 
between two points using the user defined settings.  Current tuning inputs 
a square wave of specified force amplitude into the current loop instead of 
performing a position move.  NOTE: Tuning uses relative positioning.  Make 
sure that you are aware of your actuators position with relation to its stroke 
length before performing any moves to prevent a crash. 

   • Home Here: Declares home position value of 0.0 at the current position

   • Restore Initial Values: Restores to the drive the initial tuning values saved when 
the tool was opened.  Note that is not a restore to factory defaults.  In order to 
do this, you should run the File->Restore Drive to Factory Settings command 
from the TMI menu

 NOTe: For the majority of setups, the user will only need to adjust the Bus Voltage and the 
Reflected Inertia Match slider. It is recommended that users do not modify the Current PI loop 
tuning parameters if using Tolomatic standard motors.  

Advanced Option - Adjusting the Tuning Range Min/Max: If more range is desired, 
each bandwidth’s combo box min/max can be adjusted by right clicking on that 
parameter’s combo box, and selecting “Adjust Min/Max”.

16.1.2 Graphing Pane
The graphing pane can display variables recorded during motion so the effects 
of changing tuning parameters can be seen.  The drive supports a limited sized 
internal buffer for onboard sampling. The data is transferred after a move has 
completed.

   • Graphing Profiles: Selectable outputs that can be graphed for analysis

   • Sample Rate: Rate in Hertz at which parameters are sampled

   • Sample Length: The total length of the sampling period, in seconds

   • Control Loop Diagrams: Helpful diagrams that display the input and outputs of 
each PI loop

   • Scope Data Transmit Rate: Controls speed at which scope data is transmitted 
from drive. In high gain systems, data transmission can cause instability.

 NOTe: The linear units are always in drive default (mm), even if the user units are in inches or revolutions. This 

is solely for graphing speed purposes.
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Figure 16-3: Position PID Loop

Figure 16-4: Velocity PID Loop

Commanded
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Figure 16-5: Current PID Loop
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16.2 Servo Tuning using TMI – Quick Start Guide
16.2.1 Initial Tuning for Motor Power-On and First Motion

Tolomatic Motion Interface (TMI) references a motor catalog containing default 
tuning values for each motor option. TMI has controls that allow simple or complex 
tuning adjustment. During startup, use the simple adjustments. Before enabling the 
motor using the Motion Manager, open the Tuning window and set the bus voltage 
to match the drive’s power supply. Note that the Reflected Inertia slider bar is set to 
5. Enable the motor, if it vibrates loudly, quickly disable the motor, lower the inertia 
setting by 1.0 and try again. When the motor doesn’t vibrate perform a simple 
position move to check responsiveness and stability. The Homing move can now be 
performed to set the actuator’s zero position. 

16.2.2 Quick Tuning for 80% of Applications
When the motor has been enabled, holds position, and homed, then fine tuning can 
be performed. In the Tuning window setup two position move profiles in the Test 
Move area at about one third of the applications peak velocity or try 10 Revs/Sec. 
Do not begin with a high speed move. Click the play button to run the two moves 
continuously. Now the inertia slider bar and other settings can be adjusted. The 
updates take effect at the beginning of the next move. If a fault such as Position 
Error occurs then temporarily set the fault limit to a larger value in the Safety/Limits 
Tab until the unit is tuned.

Next, select Velocity radio button under Common Tuning Profiles. When the motion 
sequence is running begin adjusting the Reflected Inertia Match left or right. Try to 
make the Actual Velocity follow tightly to Profile Velocity. Keep any overshoot to less 
than 10%. Also, try adjusting velocity feed forward gain between 75 and 100%. 
Lastly, click on the Position tab and adjust position proportional gain up or down (try 
going from 12 to 6 or 20). A higher position gain will reduce position error but may 
lead to vibration. To reduce vibration either slightly decrease the Inertia or reduce 
the position gain. Lowering position gain may provide smoother motion but also may 
require increasing the Inertia to regain stiffness. 

Now run the motion profile desired in your application. Run through the above 
adjustments again until motion is acceptable. Save setting to Flash memory and 
continue with drive setup. The scope’s auto-zoom may make motion look worse 
than it is at times. Check the axis units if in doubt. Look visually for smoothness and 
listen for audible characteristics. 

16.2.3 Common Tuning Adjustments
Slow move with small position error – turn up the position proportional gain. If 
it becomes unstable reduce the Reflected Inertia value. Adding mechanical inertia 
can help reduce the velocity ripple. If the position error does not trend toward zero 
during the motion then increase position integral gain. 

Fast smooth move – the velocity loop should be tuned stiff (turn up Reflected 
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Inertia to just before it vibrates or all the way to 10 if it never vibrates) and reduce 
position proportional gain, try around 6. Try 100% on Velocity Feed Forward gain.

High friction system – this usually requires more velocity integral gain. First 
try selecting the checkbox for High Friction. This amplifies both proportional and 
integral gains automatically to drive harder through the friction. Adjust the Inertia 
slider. 

High inertial load – this is difficult and can sometimes respond opposite as 
expected. First try adjusting the Inertia slider up and down to get controlled motion. 
Be careful, a large load can begin to oscillate out of control. Find your upper and 
lower limits in the Inertia, and set somewhere in the center. Next adjust position 
proportional gain up and down based on how the motion reacts. Start with lower 
accel/decel values. High inertia combined with high accel/decel can cause back-
emf which can fault the power supply.  If this occurs, either a voltage clamp or an 
adjustment to the motion profile is required.

Low inertia, low friction load – the Inertia setting should be set around 1-3 
such as the case for driving the motor with no load attached. High friction checkbox 
should be unchecked. This is a difficult to tune scenario because there is not much 
inertia to keep the motion smooth and motor torque ripple can be noticeable. For 
smoothness at mid to higher speeds, reduce position proportional gain (try 2-4), 
set velocity feed forward to 100% to drive more with the velocity profile signal. Test 
various Inertia settings. For tight position control and/or lower speeds, try increasing 
the position gain to drive more with the position profile signal. 

Motor sounds crunchy when holding position – this is from stiff tuning and 
updates in velocity feedback signal are amplified through the control loops, try 
reducing the Filter Frequency on the Velocity tuning tab to 50-200 range.

Motor is chirping or whining – soften the current gains, try the lower left corner 
of the Tuning Zone. Make sure the bus voltage setting is correct for your power 
supply.  Also try softening the current loop (lowering the current proportional and 
integral gains).  Enabling Eco-Mode (Safety/Limits Tab) can also help with this 
scenario.

Gearbox reduction – Start with a low Inertia setting of 1-3. A gearbox reduces 
the reflected inertia by the square of the gear ratio. With light loads this acts like a 
motor with no load attached and needs low gains. Any amount of backlash would 
also require low gains. 

16.2.4 Advanced Tuning for Demanding Applications
The proportional and integral loop gains can be adjusted independently beyond 
default values to obtain tuning that the Inertia slider bar and High Friction checkbox 
cannot achieve. 

Note: To reset tuning values to factory settings, click the Load Default Tuning or 
Restore Initial Tuning buttons and the bottom of the screen. 

Tuning Order: Always tune current loop first (usually this is not necessary as it is 
already pre-tuned at the factory) followed by the velocity loop, and last the position 
loop.
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effect of Gains: Generally, an increase in proportional gain makes the motor react 
faster to a change in the trajectory signal, adjusting too high will cause overshoot 
and fast oscillations. An increase in integral gain reduces steady-state error 
(constant trajectories), too much will cause large sinusoidal oscillations.

Repeatable Method: For the loop being tuned, turn integral gain off or almost 
off, then while running the motion sequencer, turn up proportional until the motion 
starts to oscillate hard and become unstable. Then take that value multiply it by 0.4 
and use that value. Then begin turning up integral gain until the desired steady-
state error is reached. 

Velocity motion for Fine-Tuning the Velocity Loop

The velocity loop and velocity feed forward signal typically has the greatest effect to 
drive the motor when under high load; so it’s important that this loop is tuned well. 
To tune velocity loop with the above Repeatable Method, it is often useful to run the 
velocity move type that generates an ideal velocity command using a square wave 
and monitors position to keep it in actuator’s stroke range. It removes the position 
loop output from driving the velocity. This option is only available when actuator type 
is set to rotary (Actuator Tab). If you are tuning a linear actuator then temporarily 
set the actuator type to rotary and setting the stroke limit in the Safety Limits 
tab. Caution: this motion has fast deceleration and can cause significant 
voltage spike on some power supplies, a voltage clamp is recommended. 

Attach the application load and set the Inertia value to 10. Slowly jog actuator 
to center position of the stroke before starting this velocity tuning method. Set 
the velocity to 15-20% of the motor’s max RPM or lower if your system is speed 
sensitive. Set the distance to stay within the stroke limit. Set the Velocity Feed 
Forward and Force to 100% so the speed will reach profile values. Click Play button 
and tune using the Repeatable Method above. When finished, test a position move. 
A position move may be very stiff at this point, just decrease the Inertia setting a bit. 
Click Save to Flash button and File->Save As to save a drive setup .xml file that can 
be loaded onto other drives. 

16.2.5 Troubleshooting
Motor makes chirping sound - Check the Bus Voltage setting. If set to 24V and 
the supply is 48V the motor will have a chirping sound.

Vibrating – The motor is tuned too stiff or there is excessive backlash in the 
system between the motor and the load. An attached gearbox may require a lower 
Inertia setting. 

Sluggish – The system may have high friction or drag or heavy load. Turn the 
Reflected Inertia setting up. If still sluggish at 10 setting then check box for High 
Friction. If still sluggish, start moving the velocity gain up and to the right on the 
graph in the Tuning Zone area. 

16.3 Gain Adjustments and effects
The following section describes generally what each gain adjustment does with 
relation to motion using the Tuning Filter dialog.
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16.3.1 Position Proportional

Figure 16-6 – Good Position Proportional Gain

A good position proportional gain setting should follow the position profile closely 
without much overshoot. This gain affects how quickly the control loop can follow a 
fast change in commanded position. 

Figure 16-7: Position Proportional Gain - Too High: Oscillations

Figure 16-7: Generally the higher the proportional gain the faster the control loop 
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can follow a fast change in the position command. A Position proportional gain too 
high can create oscillations and rough motion. 

Figure 16-8: Position Proportional Gain - Too Low: Large Position error

Figure 16-8: Position proportional gain too low can be sluggish and fall behind the 
desired motion profile. Falling behind creates position error that can accumulate 
during the move and then take a while to wind down causing an overshoot of the 
desired position. 

16.3.2 Position Integral

Figure 16-9: Good Position Integral Gain
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Figure 16-9: A good position integral gain setting should follow the position profile 
closely without much overshoot and it should settle to a steady state position equal 
to the commanded position. 

Figure 16-10: Position Integral Gain – Too Low: Slow steady-state response

Figure 16-10: A position integral gain set too low can increase position error during 
motion and slow the steady-state response of seeking the final position value. 

Figure 16-11: Position Integral Gain - Too High: Overshoot which gets corrected over time
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Figure 16-11: A high position integral setting can accumulate error during the move 
and cause too much overshoot of the final position. Some overshoot oscillation can 
occur also. 

16.3.3 Velocity Proportional

Figure 16-12: Good Velocity Proportional Gain

Figure 16-12: A good velocity proportional gain should create quick loop response 
to a fast change in velocity. Proportional gain will affect mainly the rising and falling 
slopes of the velocity profile. 

Figure 16-13: Velocity Proportional Gain - Too High: Large Oscillations in Velocity

Figure 16-13: Setting velocity proportional gain too high can result in large 
oscillations in velocity during a move.DISCONTIN
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Figure 16-14: Velocity Proportional Gain - Too Low: Slow Velocity Response

Figure 16-14: Setting a velocity proportional gain too low can result in sluggish 
response to changes in velocity. It may not even reach the commanded velocity 
value.

16.3.4 Velocity Integral

Figure 16-15: Good Velocity Integral Gain

Figure 16-15: A good velocity integral setting will help reduce the error in the 
constant velocity section of the velocity profile. DISCONTIN
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Figure 16-16: Velocity Integral Gain - Too High: Oscillations

Figure 16-16: Setting the velocity integral gain too high can cause oscillations 
in the constant velocity section of the velocity profile. It can increase the velocity 
overshoot.

Figure 16-17: Velocity Integral Gain - Too Low: Steady-state velocity error 

Figure 16-17: Too low of velocity integral gain will result in the loop not tracking to 
desired velocity resulting in steady-state velocity error.
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16.3.5 Velocity Feed Forward

Figure 16-18: Default Velocity Feed Forward Gain (75%)

Figure 16-18: To increase performance and lessen the burden of control on the 
position loop, a velocity feed-forward (VFF) gain as an input to the velocity loop. 
Generally this value should not need to be adjusted much from the factory default 
setting.

Figure 16-19: Velocity Feed Forward Gain (0%) - Higher Position error, higher velocity 
error

Figure 16-19: Decreasing the VFF gain or setting it to zero will cause the control 
response to be very sluggish. A higher position loop gain may be needed to get 
acceptable motion. The maximum velocity achievable may be reduced based on the 
position loop gains. Position and velocity error will increase.DISCONTIN
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Figure 16-20: Modified Velocity Feed Forward Gain (100%) Low position and velocity error, 
causes overshoot

Figure 16-20: Too much VFF gain will cause velocity overshoot and possibly position 
overshoot.

16.3.6 Current Proportional

Figure 16-21 - Good Current Proportional Gain

Figure 16-21: A good current proportional gain setting will have a fast response to 
changes in current command.
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Figure 16-22: Current Proportional - Too High: Visible Oscillations

Figure 16-22: Setting the current proportional gain too high will cause high 
overshoot and oscillations in response to fast changes in current command.

Figure 16-23: Current Proportional - Too Low: Sluggish Response

Figure 16-23: Setting current proportional gain too low will cause sluggish response 
to changes in current command. 

16.3.7 Current Integral

Figure 16-24: Good Current Integral

DISCONTIN
UED



ACS Servo Drive /ACSI

 ACSI Motor/Drive/Controller User Guide:           TMI Motion Control Interface
 •  99  •ACS Drive: DISCONTINUED Product 05/02/2022 For legacy ACS drive, use this manual for reference only.

16 :   T U N I N G  F I L T E R

Figure 16-24: Good current integral gain should reduce steady state current error.

Figure 16-25: Bad Current Integral - Too High: Large Overshoot and oscillations

Figure 16-25: Too much current integral gain will cause large overshoot spikes in 
current and oscillations to occur

Figure 16-26: Bad Current Integral - Too Low: Actual not reaching commanded

Figure 16-26: Too little current integral gain will have large steady state current 
error.

16.3.8 Current Tuning
The user should not need to touch the current tuning gains for Tolomatic motors.  
However, if the need should arise, the following method can be used to tune the 
current loop.

Step 1: Set Integral Gain to 0, and set proportional gain to about 300DISCONTIN
UED
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Step 2: Set Step force to 30% and start the Test Move

This will inject a 100 Hz commanded current square wave directly into the current 
loop to see how the control loop response to an ideal step input signal. The gains 
should be adjusted to make the actual current fit closely to the commanded current 
with little overshoot and steady-state error. 

Figure 16-27: Current Loop Starting Point

Step 3: Increase Proportional Bandwidth until visible oscillations appear.  

About 3-4 oscillation periods should be visible after the edge of the step input 
signal. 

Figure 16-28: Current Loop Tuning - Proportional Bandwidth Oscillations

Step 4: Set Proportional Bandwidth to 40% of the oscillation bandwidth.

In our example, we saw oscillations at a bandwidth of 1931.18.  1931.18 x .40 = 
772.472

Step 5: Increase Integral Bandwidth slowly until desired response is 
reached.  

This starting point is as follows, with integral set at .01:
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Figure 16-29: Current Loop Tuning - Integral Bandwidth @ .01

As you increase, the level of the signal will rise. Try to keep the overshoot under 
10%.

Figure 16-30: Current Loop Tuning - Integral Bandwidth @ 180
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The Digital I/O tool is launched from the Tools Menu in the TMI interface menu bar 
or the Tool Bar. This tool shows the current status of the physical I/O interface. The 
description of each input and output is dependent on the I/O configuration from the 
I/O Tab (see Section 10: I/O Tab)

Figure 17-1: Launching the Digital I/O Tool

Figure 17-2: Digital I/O Tool

Digital I/O Tool17
17.1 using the Digital I/O Tool
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The Analog I/O tool is launched from the Tools Menu in the TMI interface menu 
bar or the Tool Bar. This tool shows the current status of the physical Analog I/O 
interface. The units will be Volts or mAmps as determined by the Analog Position 
Settings (see Mode Select tab Section 9.1)

Figure 18-1: Launching the Analog I/O Tool

Figure 18-2: Analog I/O Tool

18.1 using the Analog I/O Tool

Analog I/O Tool18
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The Software Oscilloscope uses the USB communications interface to continuously 
poll user selected parameters.  This tool is useful for live system debugging where a 
lower update rate is acceptable (~15-25ms).  

19.1.1 Select Channels
   • Channel 1-4: User selectable parameters (up to four) to display

   • Channel Settings: Channel specific configuration items

19.1.2 Triggering
   • Auto Trigger: Continuously polls the drive and automatically updates the graph 

as data arrives.  Performs the same function as Auto Update + Start Listening

   • Manual Trigger: When Listening, Manual Trigger triggers the start of a sample, 
and will display the data after the sampling has completed

Software Oscilloscope19
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19.1.3 Parameter Trigger (Offline Sampling Only)
   • Trigger Channel: The user selected channel to use as a trigger input

   • Trigger Condition: A conditional statement to be used in conjunction with Trigger 
Channel and Trigger Condition Value.  For instance if the Trigger Condition is 
“LESSTHAN”, sampling would occur when Trigger Channel is less than the 
Condition Value.  

   • Trigger Active: Activate the triggering condition

19.1.4 Sampling Controls
   • Start Listening: Start polling the drive for the selected channels.  Used in 

conjunction with Triggering.  When a trigger is detected, the sampling queue 
fills and is displayed when the queue is filled

   • Stop Listening: Stops the drive polling and prevents the currently displayed data 
from being overwritten

   • Auto Update: When listening, the trigger condition will be constantly true, 
forcing the queue to be updated and graphed continuously

Cursor Information displays data to the user when the user clicks on two different 
places in a graph.  This will display X and Y values as well as distance and time 
between the two mouse clicks.

19.2 Channel Definition Window
Accessible from the Channel Settings button

   • Output Channel: Selected parameter for the channel

   • Chart Area: Assignable to a specified chart area (0-3).  It is possible to have 
multiple channels graphing to the same chart area
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   • Color: User definable channel color

   • Y Axis Assignment: Useful for graphing multiple parameters that require 
different scaling

    o Primary: Left Y Axis

    o Secondary: Right Y Axis

19.3 Menu Strip
19.3.1 File

   • Export Graphs

    • As CSV: Exports the data displayed in a CSV format

    • As Image: Saves the graph as an image

   • Advanced Tools

    • Get Time From Drive: Uses drive time instead of arrival time for  
 sample timestamps

    • Time Index at Zero: Uses a zero based relative time index for graphing  
 of the data instead of actual time

19.3.2 Profiles

   • Default: All available configured signals

   • Current: Only Current related signals

   • Velocity\Position: Only Velocity and Position signals

   • *Network Diagnostics: Special network specific signals (ACS Stepper & Servo)

 NOTe:  *Network 
Diagnostics: Special network 
specific signals is not available 
for ACSI  
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   • Load From File: Load saved signals from a file

   • Save Profile As…: Saves the currently loaded signal profile to disk

19.3.3 Sampling Controls

   • Start Listening: Start polling the drive for the selected channels.  Used in 
conjunction with Triggering.  When a trigger is detected, the sampling queue 
fills and is displayed when the queue is filled

   • Stop Listening: Stops the drive polling and prevents the currently displayed data 
from being overwritten

   • Manual Trigger: When Listening, Manual Trigger triggers the start of a sample, 
and will display the data after the sampling has completed

   • Sampling Parameters: Launch Sampling Parameters options window

   • Toggle Advanced Controls: Hides/Shows the Controls frame at the bottom of the 
graph (enabling a larger graphing area)

19.3.4 Sampling Parameters Options Window

   • Sample Buffer Size: Sample Size of the circular sampling buffer for each 
channel

   • PreSample Buffer Size: Number of samples to save before a trigger occurs.  In 
auto trigger mode, this is automatically set to 0
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   • Sample Rate: Best effort sampling poll rate from TMI to the drive.  The sample 
rate may be slower based on transfer rates, number of channels being 
sampled, etc

   • Apply Sample Rate: Applies the changes made to the Sampling Parameters

   • Use On Board Sampling: Some drives provide on board sampling for higher 
sample rates. When available, this option will allow on board sampling and off 
board viewing. This option is only available if TMI is in control of motion. 

19.4 Context Menu Strip (Right click on graph)
19.4.1 Zoom Out: Zooms out of the graph

19.4.2 Sampling Controls

   • Start Listening: : Start polling the drive for the selected channels.  Used in 
conjunction with Triggering.  When a trigger is detected, the sampling queue 
fills and is displayed when the queue is filled

   • Stop Listening: Stops the drive polling and prevents the currently displayed data 
from being overwritten

   • Manual Trigger: When Listening, Manual Trigger triggers the start of a sample, 
and will display the data after the sampling has completed

19.4.3 Copy to Clipboard

   • Image: Copies the graph as an image to the clipboard so it can be pasted into 
external applications
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   • CSV: Copies the data as CSV text into the clipboard so it can be pasted into 
external applications

 

19.4.4 export As…

   • Image: Saves the graph as an image

   • CSV: Exports the data displayed in a CSV format

 

19.4.5 Change Sample Series Type

   • Default (Line): Straight Line connecting sample to sample
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   • Step Line: Step function between samples (Digital)

    

   • Spline: Smoothing transitions between samples

    

   • Column: Each sample is represented by a column

    

DISCONTIN
UED



 ACSI Motor/Drive/Controller User Guide:           TMI Motion Control Interface
 •  111  •ACS Drive: DISCONTINUED Product 05/02/2022 For legacy ACS drive, use this manual for reference only.

19 :   S O F T W A R E  O S C I L L O S C O P E

   • Point: Each sample is represented by a point

    

 

19.4.6 Graph

   • Reset Axis Scales: Forces the redrawing and auto-scaling of the axis scales for 
all of the graphs
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20.1 using the Drive Status Tool
The Drive Status Tool is launched from the Tools Menu in the TMI interface menu 
bar or the Tool Bar. This tool shows the current status of critical information about 
the drive.

Figure 20-1: Launching the Drive Status Tool

ACS Stepper Drive

ACS Servo Drive / ACSI

Figure 20-2: Drive Status Tool

Drive Status Tool20
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Ethernet Setup Tool21
21.1 using the ethernet Setup Tool

Choose the Tools -> Ethernet menu selection or press the Configure Ethernet button 
in the toolstrip.

 Figure 21-1: Launching the ethernet Setup Tool

21.1.1 ethernet Setup Tool for ACS Stepper and ACS Servo 
Drives

Figure 21-2: ethernet setup tool

Enter the IP address, Subnet Mask and Default Gateway parameters for the 
network.  (The values shown above are the factory default values for the ACS drive.  

 TROUBLESHOOTING 
NOTE: For proper, timely 
communications the drive 
should be Full Duplex, 
100.00 mbps. If the drive 
negotiates Half Duplex, 10 
mbps, a network device 
has forced the drive into 
this mode and should be 
removed.
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Typically, at least the IP address and Default Gateway will need to be changed for 
the network.) Settings are downloaded when OK is pressed.

Feature Description Troubleshooting Tips
Obtain an 
IP Address 
automatically

Enables DHCP support on 
the drive, allowing a server to 
assign an IP address to the 
drive 

IP Address IP Address of the drive The ACS Drive supports Ping. Pinging the 
drive is a great way to verify that the drive 
is on the network.

Subnet Mask Subnet Mask of the drive
Default Gateway Default Gateway of the drive
Enable UDP 
Socket Support

Enables TMI to connect to drive 
over the network using port 
7023

Firewalls may automatically block 
Port 7023.  Check with your network 
administrator if you are not able to 
connect over this port, but are able to ping 
the drive.

MAC Address MAC Address of the drive
Link Status Current connection status of the 

drive (Up / Down)
If the Link Status reports Down, Ethernet 
communications will not function. Check 
physical connections, and verify lights on 
Ethernet ports are on.

Duplex Mode Communications Duplex Mode 
(Full / Half)

For the Network Controlled modes 
(eIP and Modbus TCP), the drive is 
required to be in Full Duplex mode. 
If the drive is reporting Half duplex, 
errors are dropped connections are 
expected.

Speed Communications Speed of the 
connection (10 Mbps or 100 
Mbps)

OK Applies the settings and exits 
the tool

Test Initiates a Ping connection test 
to the drive

The PC and the drive must be configured 
and connected to the same network.

Default Resets the Ethernet settings to 
the factory defaults

Cancel Exits the configuration tool
Table 21-1: ethernet connection troubleshooting tips

The test button can be used to initiate a ping test to the drive. The PC and the drive 
must be connected to the same network.

NOTE:  An Ethernet cable must be connected from the PC to the ACS drive.

If the Test worked, a screen will pop-up showing similar results to the following.

  
TROuBLeSHOOTING TIP: 

The drive may need to be reset 

in order for other network 

devices to recognize the new 

network settings..DISCONTIN
UED
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Figure 21-3: Testing verifies a successful ethernet connection

If the Test didn’t work (in this example, the Ethernet cable was unplugged from the 
ACS drive) an error dialog will be shown.

Figure 21-4: Testing indicates a failed attempt for ethernet connection

A "Yes" response will open the Ping Test window that will continually ping the 
address and give you a visual online/comment state.

Figure 21-5: Ping Test failure and success

To configure the ACS drive for DHCP server in order to dynamically assign an IP 
Address:

   • check the “Obtain an IP address automatically” check-box

   • click OK on the ACS Internet Protocol (TCP/IP) Properties dialog

   • click the Disconnect button on the TMI Drive tab (or press the Disconnect from 
Drive button on the toolstrip)

   • click Yes when asked “Update drive flash memory?”.

   • cycle ACS drive power (turn off then turn on)

   • press the Connect button on the TMI Drive tab (or press the Connect to Drive 
button on the toolstrip)

DISCONTIN
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ACSI 
Integrated

When the Ethernet configuration tool is opened, the status bar informs the status of 
the DHCP address configuration process.  This is not dynamically updated.  To see 
the current status, press Cancel (or OK), wait a bit, then open this tool again.

Figure 21-6: Obtaining an IP address automatically

If there is a problem and the ACS drive is unable to get an IP address from the 
DHCP server, the status bar will display the error message in the status bar.

When Ethernet configuration is complete, press OK.

21.1.2 ethernet Setup Tool for ACSI Motor/Drive/Controller 
Infrastructure Mode
For drives that support Infrastructure Mode, this mode allows all network 
configuration of the drive to be done using the users existing Network Infrastructure.  
By default, infrastructure mode is in DHCP mode.  However, the users network 
infrastructure can assign a static IP address using existing protocol objects (such as 
Ethernet/IP connection object).  

While in this mode, the user cannot access the network settings through TMI, but is 
able to use the ping support tool.  

Figure 21-7: By default, infrastructure mode is in DHCP mode

 NOTE: PROFINET and 
EtherCAT only support 
Infrastructure Mode.

 NOTE: Minimum 
DHCP IP address lease 
time is 24 hours.
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ACSI 
Integrated Infrastructure mode can be disabled, and the user can specify network settings 

using this tool.  

Non-Infrastructure Mode
Drives that use protocols that do not support infrastructure mode (such as Modbus 
TCP) will have a subset of the functions available in Infrastructure Mode.  

Feature Description Troubleshoot Tips
IP Address IP Address of drive Pinging the drive is a great 

way to verify that the drive is 
on the network

DHCP Obtain an IP Address Automatically 
from DHCP server

Minimum DHCP IP address 
lease time is 24 hours.

Subnet Mask Subnet Mask of the drive
Default 
Gateway

Default Gateway of the drive

Hostname Hostname of the drive
DNS1 DNS Server for the drive
DNS2 Alternate DNS server for the drive
Enable UDP 
Support

Enables Network access through 
TMI

Ping Test Initiates a ping connection test to 
the drive

PC and drive must be 
configured and connected to 
the same network

Apply User 
Settings

Applies new configuration settings 
to the drive and resets ethernet 
module

Figure 21-8: ethernet (TCP/IP) Properties

  
TROuBLeSHOOTING TIP: 

Drive may need to be power 

cycled after new network 

settings are applied for other 

network devices to be able to 

"see" the drive.
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ACSI 
Integrated The Ping Test button can be used to initiate a ping test to the drive.  The PC and 

drive must be connected to the same network.  If successful, a screen will pop up 
showing the results of the ping.

Figure 21-9: ethernet connection test

A continuous ping test will continuously ping a drive, noting when the drive is 
accessible and when it is not. 

Figure 21-10: Drive not accessible

Figure 21-11: Drive is accessible
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ACS Stepper
& 
ACS Servo 

Ethernet Advanced Diagnostics22
22.1 using ethernet Advanced Diagnostics (not available for ACSI)

When connected to Ethernet enabled ACS drives TMI will display Ethernet MIB 
Counters in Tools > Advanced Diagnostics Menu.

Figure 22-1: Advanced Diagnostics pull-down

22.1.1 Management Information Base (MIB) Counters
The ACS Drive provides 30 MIB counters per port. These counters are used to 
monitor the port activity for network management. Counters are polled every 10 
seconds while the dialog box in Figure 22-2 is visible. When closed, polling stops. 
Pink highlighted text box indicates a problem reading the counter (this should rarely 
occur). Bold numbers indicate a change since previous poll. Use the box in the 
lower left corner to choose either Port 1 or Port 2: this corresponds to ACS Ethernet 
Port 1 and Port 2.

Figure 22-2: ethernet MIB Counters

 WARNING: Ethernet 
Advanced Diagnostics is not 
supported for ACSI Motor/
Drive/Controller.
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TMI LABeL DeSCRIPTION

TxOctets Tx lo-priority good octet count including PAUSE packets

Tx Dropped Packets TX packets dropped due to lack of resources

TxBroadcastPackets Tx good broadcast packets (not including error broadcast or valid multicast 
packets)

TxMulticastPackets Tx good multicast packets (not including error multicast or valid broadcast 
packets)

TxUnicastPackets Tx good unicast packets

TxCollisions Tx total collision, half duplex only

TxSingleCollisions Successfully Tx frames on a port for which Tx is inhibited by exactly one collision

TxMultipleCollisions Successfully Tx frames on a port for which Tx is inhibited by more than one 
collision

TxDeferred Tx packets by a port for which the 1st Tx attempt is delayed due to the busy 
medium

TxLateCollisions The number of times a collision is detected later than 512 bit-times into the Tx 
of a packet

TxExcessive A count of frames for which Tx fails due to excessive collisions

TxPausePackets Number of PAUSE frames transmitted by a port

RxOctets Rx lo-priority (default) octet count including bad packets

Rx Dropped Packets RX packets dropped due to lack of resources

RxBroadcastPackets Rx good broadcast packets (not including error broadcast packets or valid 
multicast packets)

RxMulticastPackets Rx good multicast packets (not including MAC control frames, error multicast 
packets or valid broadcast packets)

RxUnicastPackets Rx good unicast packets

RxUndersizePackets Rx undersize packets with good CRC

RxOversizePackets Rx oversize packets with good CRC (max: 1536 or 1522 bytes)

RxJabbers Rx packets longer than 1522 bytes with either CRC errors, alignment errors or 
symbol errors (depends on max packet size setting)

RxAlignmentErrors Rx packets within (64, 1522) bytes with a non-integral number of bytes and a 
bad CRC (upper limit depends on max packet size setting)

RxCRCErrors Rx packets within (64, 1522) bytes with an integral number of bytes and a bad 
CRC (upper limit depends on max packet size setting)

RxPausePackets
Number of PAUSE frames received by a port.  Pause frame is qualified with 
EtherType (88-0xh), DA, control opcode (00-01), data length (64B min), and a 
valid CRC

RxSymbolErrors Rx packets with invalid data symbol and legal packet size.

64Packets Total Rx packets (bad packets included) that were 64 octets in length

65to127Packets Total Rx packets (bad packets included) that were between 65 and 127 octets 
in length

128to255Packets Total Rx packets (bad packets included) that were between 128 and 255 octets 
in length

256to511Packets Total Rx packets (bad packets included) that were between 256 and 511 octets 
in length

512to1023Packets Total Rx packets (bad packets included) that were between 512 and 1023 octets 
in length

1024to1522Packets Total Rx packets (bad packets included) that were between 1024 and 1522 
octets in length (upper limit depends on max packet size setting)

Table 22-1: ACS ethernet Drive MIB counters
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22.1.2 Advanced Network Counters

Figure 22-3: Menu selection of Advanced Network Counters

The ACS Drive provides extremely low level access to the network counters 
used by the network stack implemented in firmware.  The Advanced Network 
Counters tool is an expert level tool designed specifically for deployment engineers 
troubleshooting network related issues.  While the MIB Counters provide access to 
registers on the Ethernet Hardware directly, the Network Counters are maintained by 
the ACS Firmware.  

Launching the tool from the Tools->Advanced Diagnostics->Advanced Network 
Counters will bring up the tool's interface.

Figure 22-4: Advanced Network Counters Interface

The user can select an appropriate refresh rate based on the number of 
counters selected. If only a few counters are selected, 1-5 second intervals can 
be maintained. However, the flexibility of the tool allows for an extremely high 
number of counters to be selected.  Choose a slower refresh rate to increase the 
performance of the interface.  Once the refresh rate (in seconds) is selected, click 
the "Collect Counters" button.

DISCONTIN
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The counters will be polled at the Refresh Rate interval.  As the values are collected, 
they will be displayed in a CSV format in the output window. 

Figure 22-5: Result of "Collect Counters" selection

The user can then save the CSV output to a file using the File->Save As... option

Figure 22-6: Save as .csv file for use in software like excelDISCONTIN
UED
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The user can now import this file into a data analysis application (like Excel) and 
process the data.

Figure 22-7: Result of "Collect Counters" graphed in MicroSoft excel
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23.1 using Network Assembly Remapping
The Network Assembly Remapping Tool allows users to remap a subset of the 
Network Input registers to a number of different read-only drive parameters.

The feature to remap network input assemblies was introduced in the following 
versions of firmware:

• ACS Servo Firmware Ver.   1.20+

• ACS Stepper Firmware Ver. 1.8+

• ACSI Servo Firmware Ver. 1.7+

When connected to a drive that supports Network Assembly Remapping, the Tool 
will appear under the Tools>Network Assembly Remapping menu.

 
Figure 23-1: Network Assembly Remapping pull-down

By default, Remappable Register 1 is set to Analog Input, and Remappable Register 
2 is set to Analog Output.  In all supporting programs and tools, the registers may 
be labeled by these default names.

23Using Network Assembly Remapping

DISCONTIN
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Figure 23-2 Click Apply to Remap

Clicking Apply will force the mapping to occur on the drive.  If the input assemblies 
are being monitored externally (via PLC or HMI) this should have an immediate 
effect.  

Servo and Stepper drives support different drive variables.  See the following tables 
for details. 

ACS AND ACSI SeRVO ReMAPPABLe ReGISTeRS
Analog Input (Default Register 1)
Analog Output (Default Register 2)
Actual Position (mm or revs)
Actual Position Error (mm or revs)
Actual Velocity (mm/s or revs/s)
Actual Velocity Error (mm/s or revs/s)
Actual Current (Amps) (Fast Signal)
Commanded Position (mm or revs)
Commanded Velocity (Trajectory) (mm/s or revs/s)
I2T Accumulation Value*
I2T Limit*
Bus Voltage (Volts)
Board Temperature (Drive) (Degrees C)
Digital Inputs
Digital Outputs
* When I2T Accumulation value exceeds limit, I2T 
fault occurs.  Accumulation happens any time motor 
is running

Table 23-1 - ACS and ACSI Servo Remappable Register Variables
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ACS STePPeR ReMAPPABLe ReGISTeRS
Analog Input (Default Register 1)
Analog Output (Default Register 2)
Actual Position (mm or revs)
Actual Position Error (With Encoder)  (mm or revs)
Actual Velocity (mm/s or revs/s)
Profile Position
Profile Velocity
Profile Acceleration
Profile Deceleration
Bus Voltage (Volts)
Board Temperature (Drive) (Degrees C)
Digital Inputs
Digital Outputs

Table 23-2 - ACS Stepper Remappable Register Variables
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Appendix 1: Index Move Mode - Move Select Logic

Index Move Mode - Move Select Logic Table

The three operating modes, 4/8/16 move commands, require digital inputs to select 
the desired move for execution. The digital inputs are called Move Select 1 through 
4 (MS1-MS4) in the digital input map. To select the desired move command refer to 
the three logic tables below.

NOTe 1: MS# stands for Move Select #

NOTe 2: 1 = On; 0 = Off

4 Move Commands Mode Logic Table

MOVe MS1 MS2

1 0 0
2 1 0
3 0 1
4 1 1

Table A1-1: 4 Move Commands Mode Logic

8 Move Commands Mode Logic Table

MOVe MS1 MS2 MS3
1 0 0 0
2 1 0 0
3 0 1 0
4 1 1 0
5 0 0 1
6 1 0 1
7 0 1 1
8 1 1 1

Table A1-2: 8 Move Commands Mode Logic

DISCONTIN
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16 Move Commands Mode Logic Table
MOVe MS1 MS2 MS3 MS4

1 0 0 0 0
2 1 0 0 0
3 0 1 0 0
4 1 1 0 0
5 0 0 1 0
6 1 0 1 0
7 0 1 1 0
8 1 1 1 0
9 0 0 0 1

10 1 0 0 1
11 0 1 0 1
12 1 1 0 1
13 0 0 1 1
14 1 0 1 1
15 0 1 1 1
16 1 1 1 1

Table A1-3: 16 Move Commands Mode Logic
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Pneumatic Mode - Move Select Logic Table

The pneumatic mode requires digital inputs to select the desired move for 
execution.  The digital inputs are called Move Select 1 through Move Select 3 
(MS1-MS3) in the digital input map.  To select the desired move refer to the four 
logic tables below.

NOTe 1: MS# stands for Move Select #

NOTe 2: 1 = On; 0 = Off

2 Position (1 input) Table

ACTION MS1

Pos 1 0
Pos 2 1

Table A2-1: 2 Position (1 input) Mode Logic

2 Position (2 input) Table

ACTION MS1 MS2
Stop 0 0
Pos 1 1 0
Pos 2 0 1

Current Pos 
Command 1 1

Table A2-2: 2 Position (2 input) Mode Logic

3 Position (2 input) Table

ACTION MS1 MS2
Stop 0 0
Pos 1 1 0
Pos 2 0 1
Pos 3 1 1

Table A2-3: 3 Position (2 input) Mode Logic

3 Position (3 input) Table

ACTION MS1 MS2 MS3
Stop 0 0 0

DISCONTIN
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3 Position (3 input) Table

ACTION MS1 MS2 MS3
Pos 1 1 0 0
Pos 2 0 1 0
Pos 3 0 0 1

Current Pos 
Command 1 1 1

Current Pos 
Command 1 1 0

Current Pos 
Command 0 1 1

Current Pos 
Command 1 0 1

Table A2-4: 3 Position (3 input) Mode Logic

 NOTe: If logic selects Current Pos Command, then the controller will continue to 

current commanded position. If already in position, no motion will occur. 
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Appendix 3: Tolomatic Firmware Upgrade Tool

Tolomatic Firmware upgrade Tool

 WARNING: Do not disconnect the drive during the firmware upgrade upload. 
Doing so may damage the drive. 

 NOTe: Because upgrading firmware will reset your drive to factory default state it is 

recommended that you backup your current ACS drive settings before upgrade. 

A3.1.1 Saving Current Drive Settings
After successful firmware upgrade, the Tolomatic Firmware Upgrade Tool (TFUT) 
will restore the drive to factory settings appropriate to the new version of firmware, 
overwriting any user defined settings.

Figure A3-1: using the Save As backup current ACS drive settings before upgrading 
firmware

 SAFeTY WARNING: 
Disconnect the drive from 
Ethernet, RS485, actuator, 
motor, encoder & brake before 
upgrading firmware. You 
should only have power and 
communications line (serial 
or USB) connected. Only use 
Tolomatic authorized firmware 
to upgrade your ACS drive. 
Running unauthorized firmware 
on the ACS drive will result in 
unexpected behavior.

 NOTe: This step is most 

useful if you want to BACKuP 

current ACS Drive settings 

before upgrading firmware. 

(upgrading will force the ACS 

Drive to factory defaults) After 

upgrading firmware open 

TMI software and restore 

ACS Drive settings using the 

procedure outlined at right.
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Appendix 3: Tolomatic Firmware Upgrade Tool

If you run the Tolomatic Motion Interface, connect to the drive and select the  
File->Save As menu item, you can save the current drive settings to a file.  The 
next time you run Tolomatic Motion Interface after upgrading the drive firmware, you 
can select File->Open and open this file.  The parameter settings in the file will 
automatically be programmed into the Tolomatic drive.

A3.2.1 Launching the upgrade Tool Software
1. Double-click the program icon on the desktop or in the Windows® Start menu 
at: Start > All Programs > Tolomatic > TolomaticMotionInterface > 
TolomaticFirmwareUpgrade Tool to launch the software.

Figure A3-2: Select the correct version of the Firmware upgrade Tool

 Note: If user experiences a permissions error, try running TFuT as Administrator.

Product Firmware File

ACS Stepper 36043183.TOL

ACS Servo 36043177.TOL

ACSI Integrated 36043171.TOL

A3.3.1 user Interface Process 
  • As in TMI, setting COM Port to Auto will request TFUT to scan available ports 

looking for an ACS drive and automatically select that COM port.  If the ACS 
drive does not have valid ACS firmware, the COM port must be selected 
manually.

  • Status and progress messages are displayed in the read-only text box.

  • A Show ACS Drive Info button is provided to query the Product Name, Model, 
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Appendix 3: Tolomatic Firmware Upgrade Tool

Firmware Version, and Drive Name.  This is useful in conjunction with COM 
Port: Auto.  

  • Compatibility Mode is available for systems with USB upgrade issues.

Figure A3-3 Connected to ACS Drive

• A Reset Drive button allows the ACS drive to be reset.

• If no ".tol" is specified, pressing Program will run a connection test (useful for 
troubleshooting only)

• A progress bar shows how the firmware flashing process is progressing

Figure A3-4: Firmware Flashing Progress
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Appendix 3: Tolomatic Firmware Upgrade Tool

Figure A3-5: Firmware Flashing Complete

A3.6.1 TFuT Integrated with TMI
In addition to being available as a stand-alone tool, the Tolomatic Firmware Upgrade 
Tool (TFUT) is now available from TMI.  Selecting this menu item will cause TMI to 
disconnect from the ACS drive (discarding any changes) and open a modal TFUT 
dialog.

Figure A3-6: upgrade Firmware through TMI

 TROUBLESHOOTING 
NOTE: If the upgrade 
process fails, check the 
"Compatability Mode" 
check-box and retry the 
upgrade process.DISCONTIN

UED
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NOTe: Timing Diagrams and Troubleshooting Help are found in each 

Hardware & Installation Guide

ACS Servo Hardware & Installation Guide #3604-4181

ACS Stepper Hardware & Installation Guide #3604-4183

ACSI Servo Hardware & Installation Guide #3604-4185

DISCONTIN
UED



 ACSI Motor/Drive/Controller User Guide:           TMI Motion Control Interface
 •  136  •ACS Drive: DISCONTINUED Product 05/02/2022 For legacy ACS drive, use this manual for reference only.

Appendix 4: Import / Export Other Motor Catalogs

A4.1.1 Import / export Other Motor Catalogs

1. Launch Tolomatic Motion Interface (v 3.17.0.0 or above)

2. Select File –> Other Motor / Actuator Catalog –> Import / Export

3. In Other Motor / Actuator Catalog Editor, File –> Open

4. Browse to Custom Catalog Definitions File (*.acs), Click "Open"

5. Right click on selection and select "Import to TMI"

6. Verify item now exists in TMI Definitions Catalog

7. Exit Import / Export Tool

NOTE: Custom motors require custom actuators.
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